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Antares Audio Technologies retains all ownership rights to the INFINITY
software and other software offered by Antares Audio Technologies and
their documentation. Use of INFINITY is limited by the license agreement
packaged with the envelope containing your original diskette. 

INFINITY was written with MacApp¨ : © 1985 - 1999 Apple Computer, Inc.

APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER,
EITHER EXPRESS OR IMPLIED, REGARDING THIS PRODUCT,
INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABIL-
ITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

The MacApp software is proprietary to Apple Computer, Inc. and is
licensed to Antares Audio Technologies for distribution for use in combina-
tion with INFINITY DSP Looping Tools for the Macintosh

INFINITY End-User License 
Carefully read all the terms and conditions of this license agreement prior to instaling IN
ITY. If you do not agree with the terms and conditions of this Agreement, delete INFIN
from your system and return the disk envelope unopened, along with the rest of the pa
to Antares Audio Technologies

Software License Agreement
Antares Audio Technologies grants you a non-transferable, non-exclusive license to u
ual



   

on of

  

gram

opy
 or
smis-
 is

om-
 IN-

or any
nt of

 (or

se in
rcial

  

 may
oying
ther

's fees
nt plus

  

m will
NITY
s fur-
riod of
. An-
e re-
FINITY under the terms and conditions stated in this agreement. Use of all or any porti
this package indicates your agreement to the following terms and conditions. 

License
You may:
1. use INFINITY on only one computer at a time;
2. physically transfer the program from one computer to another, provided that the pro

is used on only one computer at a time.

You may not:
1. make copies of INFINITY or of the user manual in whole or in part. Your right to c

INFINITY and the user manual is limited by copyright law. Making copies, verbal
media translations, adaptations, derivative works, or telecommunication data tran
sion of INFINITY without prior written authorization of Antares Audio Technologies,
prohibited by law and constitutes a punishable violation of the law.

2. make alteration or modifications to INFINITY (or any copy) or disassemble or de-c
pile INFINITY (or any copy), or otherwise attempt to discover the source code of
FINITY. 

3. incorporate the SPR Looper, Rotated Sums Looper or Freeze Looper algorithms, 
derivatives of them, in any software or hardware without the express written conse
Antares Audio Technologies. 

4. sub license, lease, lend, rent, or grant other rights in all or any portion of INFINITY
any copy) to others.

5. use INFINITY to make samples intended for sale to the public as samples or for u
the firmware of a musical instrument.  These uses of INFINITY require a Comme
License.  

Term of the Agreement 
This agreement is effective until terminated by you or Antares Audio Technologies. You
terminate the agreement at any time by notifying Antares Audio Technologies and destr
all copies of the manual, and erasing INFINITY from all machine-readable media, whe
on-line or on archival copies.  

In the event of breach of any of the terms of this agreement, you shall pay the attorney
of Antares Audio Technologies that are reasonably necessary to enforce the agreeme
resulting damages. 

Limited Warranty and Disclaimer
INFINITY AND ACCOMPANYING MATERIALS ARE PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FIT-
NESS FOR A PARTICULAR PURPOSE.

Antares Audio Technologies does not warrant that the functions contained in the progra
meet your requirements. The entire risk as to the use, quality, and performance of INFI
is with you. Antares Audio Technologies warrants the diskettes on which the program i
nished to be free from defects in materials and workmanship under normal use for a pe
ninety (90) days from the day of delivery to you as evidenced by a copy of your receipt
Tares System's entire liability and your exclusive remedy as to the diskettes will be th
placement of the diskettes.

SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW LONG AN IM-
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PLIED WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT APPLY TO
YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY ALSO
HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION TO JURISDICTION.

Limitation of Liability
IN NO EVENT WILL ANTARES AUDIO TECHNOLOGIES BE LIABLE FOR ANY
DAMAGES, INCLUDING LOSS OF DATA, LOST PROFITS OR OTHER SPECIAL, IN
CIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE
OF INFINITY OR ACCOMPANYING MATERIALS. THIS LIMITATION WILL APPLY
EVEN IF ANTARES AUDIO TECHNOLOGIES OR ITS AUTHORIZED AGENT HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. YOU ACKNOWLEDGE
THAT THE LICENSE FEE REFLECTS THIS ALLOCATION OF RISK. SOME JURIS
DICTIONS DO NOT ALLOW LIMITATION OR EXCLUSION OF LIABILITY FOR IN-
CIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY
NOT APPLY TO YOU. 
dy@antaresTech.com

Welcome!

On behalf of everyone at Antares Audio Technologies, weÕd like to offer
both our thanks and congratulations on your decision to purchase the Þnest
software tools for looping samples ever created. With your purchase of
INFINITY, you have begun a relationship with our company which I hope
will be long and gratifying. 

As a registered user of INFINITY, you are entitled to notiÞcation of software
upgrades, technical support, and to special introductory offers on our
upcoming products. We will be in contact with you to announce new
opportunities and to solicit your feedback. 

At Antares Audio Technologies, we are committed to excellence in service,
quality, and technological innovation. You can count on us to listen to you
and to keep our promises to you.

Again, thanks.

The Whole Antares Crew
nual



  

Table of Contents

             
CHAPTER 1 Getting Started 11

Introduction 11
Real Time Loop Adjust 11
Synthesis Looper 11
SPR Looper 12
Rotated Sums Looper 12
Freeze Looper 12
Crossfade Looper with Smart Auto-Scan 12
Fully adjustable Edit Blending 12
Complete Sample Editing Environment 12

How To Use This Manual 13
For Those Who Hate To Read Manuals… 13

The Contents Of The Manual 13
Chapter 1: Getting Started 13
Chapter 2: Introducing INFINITY 13
Chapter 3: INFINITY Basics 14
Chapter 4: INFINITY Looping Tools 14
Chapter 5: INFINITY Reference 14
Appendix A: Keyboard Equivalent Commands 14

The Equipment You'll Need 14
Minimum System Requirements 14

Owner Registration 15

Technical Support 15

CHAPTER 2 Introducing INFINITY 17

The Problem With Looping 17
Crossfade Loops 19
The Costs Of Current Methods 20

The INFINITY Environment 21
The Soundfile Window 21

Title Bar 22
Close box 22
Zoom box 22
Overview 22
View Indicator 22
Playback Position Pointer 23
Vertical Annotation 23
v



 

vi

 

INFINITY UserÕs Ma

             
Mainview 23
Track Divider and Zero Crossing 23
The Horizontal Annotation 23
Loop Points 24
Grow Box 24

The Palette 24
Mode Icons 25
Status Display 25
The Action Icons 26

Get Info… 27
Disk Based Files 28
Envelope Files 28
Backup Files 29
Balloon Help 30

CHAPTER 3 INFINITY Basics 31

Using Commands 31
Using Keyboard Command Equivalents 31
Undoing A Command 32

Viewing The Soundfile 32
Scrolling The Soundfile Data 32
Changing The Display Resolution 33

Using The Display Scale icon 33
Using The Fit Selection Icon 33
Using Zoom Mode In The Overview 33
Using Zoom Mode In The Mainview 34
Using Momentary Zoom Mode 35
Using Full Zoom In and Full Zoom Out 35

Changing Separators, Units and Scales 35
Show Zero Crossing 35
Show Track Dividers 35
Vertical Scale Units 35
Horizontal Scale Units 36

Managing Multiple Windows 36
Hiding The Overview 36

Listening to The Soundfile 36
Setting-up Sound Playback 36
Playback Auto-Reset 37
Scroll After Playback 37
nual



            
Using The Speaker Icon 37

Editing The Soundfile 38
Specifying Where To Change Sound Data 38

Using Selection Mode In The Mainview 38
Placing The Insertion Point 38
Selecting Data 39
Using Selection Mode In The Overview 40
Using Momentary Selection Mode 40

Using The Editing Functions 41
Cut 41
Copy 42
Paste 42
Clear 43
Clear Unselected 44
Clear Beyon Loop End 44
Mix 44
Invert 45
Reverse 45
Silence 45
Normalize 46
Change Gain… 46
Create/Delete Loop Points 47
Loop the selection 47
Locating Loop Points 47
Set MIDI Note… 48
Auto-Zero 48
Show Clipboard… 49

Using Edit Blending 50
Adjusting The Blend Parameters 52

Saving The Soundfile 53
Save 53
Save A Copy… 53

Reverting To The Last Saved Version 54

Customizing Your Environment 55
Enable Clipboard 55
Enable Undo 55
Blending 55
Create Backup Files 55
Customizing The Soundfile Window 56
INFINITY UserÕs Manual vii



 

viii

 

INFINITY UserÕs M

          
CHAPTER 4 INFINITY Looping Tools 57

Managing Loop Points 57
Real Time Loop Adjust 57
Undo Loop Move 58
Loop Points and Clipboard 58
Loop Points During Edits 58
Loop Points In Other File Formats 59

The Crossfade Looper 59
About Smart Auto-Scan 60
Understanding The Dialog Controls 61

Soundfile Menu 61
Looping Display 61
Auto-Scan Arrows 62
Auto-Scan Matching Value 62
Auto-Scan Settings… 62
Crossfade Length (%) 63
Crossfade Taper 63
Audition Crossfade 63
Do Crossfade 64

The Freeze Looper 64
How It Works 65
Understanding The Dialog Controls 65

Soundfile Menu 65
Pitch Control Radio 65
Pre-condition Data (%) 66
Crossfade Length 67
Crossfade Taper 67
Do It 67

The Rotated Sums Looper 68
How It Works 69
Understanding The Dialog Controls 69

Soundfile Menu 69
Process The Loop Segment 70
Merge The Attack And Loop Segments 70

The SPR Looper 72
How It Works 72
Performance Note 73
Understanding SPR Controls 73

Soundfile Menu 73
Process The Loop Segment 73
anual



        
Merge The Attack And Loop Segments 74

The Synthesis Looper 76
Introduction 76
Commentary 76
Some Theory 77
How it Works 79
Understanding Synthesis Looper Controls 80

Process the Loop Segment 81
Merge The Attack And Loop Segments 81

The Synthesis Looper Report 83
How To Loop A Sound: 87
A Final Note: 88

APPENDIX A  Keyboard Shortcuts 89

Scrolling Data 89
Changing Display Scaling 90
File Commands 90
Edit Commands 91
Looping Tools 91
Palette 91
Other 92
INFINITY UserÕs Manual ix



 

x

 

INFINITY UserÕs Man
ual



          
CHAPTER 1 Getting Started 
Introduction

Imagine being able to take a raw sample, and then, with just a few mouse
clicks, create a loop so perfect that you canÕt tell when it started or where it
repeats. Imagine doing that with sounds that are impossible to loop
smoothly using your current sample editor, like string orchestra, choirs, fat
analog synths, chorused guitar, and so on. INFINITY lets you do that,
quickly and easily.

INFINITY is a powerful DSP which uses unique DSP technologies to auto-
mate and improve the looping process (the part of sample editing that takes
the most time and skill). 

Some of INFINITYÕs special features are:

Real Time Loop Adjust

INFINITY makes Þne tuning the loop easy by letting you move the loop
points anywhere in the soundÞle during real time playback.

Synthesis Looper

The Synthesis Looper tool calculates the energy at each fundamental and
harmonic frequency and allows you to specify the width of the sidelobes the
resulting looped sound will have.  In this way, you could take the lumpy
sound of a highly out-of-tune ensemble and change it to the smoother
sound of a higher quality ensemble, making the variations in the loop repe-
tition less noticeable.
INFINITY UserÕs Manual 11
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SPR Looper

This tool automatically randomizes the spectral components of the sound
inside the loop points to create a virtually seamless result in sounds that
have irregular waveforms like string orchestra, chorus, analog synths, cym-
bal rolls, and so on. Stereo samples retain their ambience and dimensional-
ity. The SPR Looper is protected by US patent law.

Rotated Sums Looper

This looping tool uses a convolutional approach to randomizing irregulari-
ties inside the loop points. Like the SPR Looper, it is excellent for use with
all sounds that have irregular (non-periodic) waveforms. 

Freeze Looper

The Freeze Looper creates perfect loops in sounds like winds, brass, bells,
and other sounds that have a pure harmonic series. ItÕs also good for Òfreez-
ingÓ the timbre of decaying strings like piano or guitar.

Crossfade Looper with Smart Auto-Scan

This is an enhanced crossfade tool with an intelligent loop point scanner. It
uses a sophisticated DSP algorithm to Þnd the right loop point automati-
cally. 

Fully adjustable Edit Blending 

This editing feature allows the taper and length of the blend crossfades
used during edit operations to be adjusted to suit the sound you are work-
ing on.

Complete Sample Editing Environment 

The INFINITY environment provides all the basic tools necessary to create
professional quality samples easily and quickly. 

INFINITY is robust. It lets beginners get results which are superior to pro-
fessionals using other programs. For professionals, INFINITY provides a
level of quality, speed, and ease of use inapproachable by any other sample
editor.
nual
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How To Use This Manual

INFINITY has a transparent user interface, has excellent Balloon Help and
is extraordinarily easy to use. However, the operation of the DSP Looping
Tools and some functions of the user interface will not be immediately obvi-
ous because they do things which have never been done before. We
strongly recommend that you read the following sections of the manual to
take full advantage of the quality and speed that INFINITY makes possible.

∞ See ÒThe INFINITY EnvironmentÓ on page 21.

∞ See ÒViewing The SoundÞleÓ on page 32.

∞ See ÒEditing The SoundÞleÓ on page 38.

∞ ÒSaving The SoundÞleÓ on page 53.

∞ See ÒCustomizing Your EnvironmentÓ on page 55.

∞ Chapter 4: ÒINFINITY Looping ToolsÓ on page 57.

For Those Who Hate To Read ManualsÉ

We recommend that you leave the manual within reach when Þrst learning
INFINITY. When you come across something that you donÕt understand,
take a few moments to look it up in the Index and read about it. The time
invested will be well rewarded.

The Contents Of The Manual

Chapter 1: Getting Started

This chapter explains everything about starting INFINITY, communicating
with Antares Audio Technologies, and using the manual.

Chapter 2: Introducing INFINITY

This chapter explains the scope of INFINITYÕs functions and how it solves
current problems in the electronic music studio. Basic concepts in sample
editing and Þle management are also covered. The user interface is
INFINITY UserÕs Manual 13
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explained with emphasis on the anatomy of the Palette, and the SoundÞle
Window.

Chapter 3: INFINITY Basics

INFINITY Basics explains how to perform all the basic functions in manipu-
lating and editing a soundÞle. The topics covered are; Using Commands,
Viewing The SoundÞle, Editing The SoundÞle, Saving The SoundÞle, and
Customizing Your Environment.

Chapter 4: INFINITY Looping Tools

This chapter contains detailed instructions on how to use the looping tools.
We recommend this chapter as ÒmustÓ reading for everyone.

Chapter 5: INFINITY Reference

This chapter explains every object and function in INFINITY. Items are
organized in alphabetical order by name. An in-depth explanation of each
item is given.

Appendix A: Keyboard Equivalent Commands 

This appendix contains a list of all the keyboard equivalent commands and
shortcuts that can be used with INFINITY.

The Equipment You'll Need

Minimum System Requirements 
INFINITY will run on Macintosh Power PCÕs only.
nual
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Owner Registration

Your purchase of INFINITY entitles you to technical support, special intro-
ductory offers on new products from Antares Audio Technologies, and noti-
Þcation of software updates. Software updates will be published regularly
as the program evolves. Major updates and new products currently in
development will be announced at a signiÞcant discount, but only to regis-
tered users.

Please Þll out and return the Owner Registration Card. The information on
the card will allow us to communicate more effectively with you and will
enable us to serve you better in the future.

Technical Support 
If you have some problem using INFINITY that canÕt be solved by reading
the manual, call technical support at (888) 332-2636, or (408) 399-0008 Mon-
day through Friday between 9 AM to 5 PM PaciÞc Standard Time.

Also, you might Þnd what you want at our web page:

www.antaresTech.com

You can also e-mail:

techsupport@antaresTech.com
INFINITY UserÕs Manual 15
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CHAPTER 2 Introducing INFINITY
Samplers and sample players have become the most popular electronic
musical instruments because of the realism and Þdelity made possible by
digital recording techniques. This realism comes at the price of ever increas-
ing memory requirements needed to produce the sustained tone of natural
instruments. Since samplers have Þnite memories, rudimentary looping
techniques have been used to create the illusion of sustained tones, but
often with less than satisfactory results.

The Problem With Looping
An ideal loop sounds like a uniform sustained tone. An imperfect loop is
detectable because one hears repetitive changes in the tone. Using standard
looping techniques, it is possible to create an ideal loop only under special
conditions. These conditions are:

1. The waveform being played must be perfectly uniform during the duration of the 
loop (which may be thousands of cycles long), and

2. The loop must start and end at the same point in the period of the waveform.

This means that a perfect loop can only be created by using a sustained peri-
odic waveform. But this type of sound is only a small sub-set of the sounds
used in music making. Sustained sounds come in two varieties:

∞ Periodic sounds : Sounds recorded monophonically which have stable
tone, loudness, and pitch. Examples are solo wind and brass instru-
ments, organ, and so on.
INFINITY UserÕs Manual 17
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∞ Non-periodic sounds : Some examples of non-periodic waveforms are
instrumental ensembles like string sections, brass sections, choirs, cho-
rused guitar and keyboard sounds and many waveforms from the older
analog synthesizers. Sounds that change tone as they decay like piano,
harp, timpani, bells, cymbal rolls, etc. are also non-periodic.

Clearly, most of the sustained sounds that are used for music making are
non-periodic. It is impossible to make an ideal loop of a non-periodic
sound. The simple fact that the sound changes with time will cause the
repetitive nature of the loop to show up.

The problem becomes even more difÞcult when considering the stereo case.
If there are even slight changes to the shape of the two waveforms then it
becomes impossible to Þnd loop points where the waveforms precisely
match. (A stereo loop cannot have a separate loop point for the left and
right channel because doing so would not preserve the stereo relationship
between the channels in the reproduced output.) The illustration below
shows a segment of a stereo recording of a violin section playing a single
pitch. Note that the two waveforms donÕt even resemble each other. 

Periodic Waveform:
Digiwave

Non-periodic Waveform:
Violin Section

Violin Section:
Left Channel

Violin Section:
Right Channel
nual
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Crossfade Loops 

One common compromise for looping non-periodic sounds is to blend the
sound leading up to the loop end point with sound around the loop start
point. This is called a crossfade. This tends to make the transition from loop
end to loop start less abrupt.

No technique will ever loop a non-periodic sound without leaving irregu-
larities somewhere in the loop. The problem with a crossfade loop is all of
the different frequencies in the sound make a transition from one phase to
another during the crossfade. This causes different combinations of con-
structive and destructive interference. Because this happens for all frequen-
cies at the same point in the loop, a noticeable bump is produced by the
crossfade loop.

The illustration below shows the process of creating a crossfade loop. The
waveform segment labeled ÒattackÓ is the part of the sound that is heard
before the loop begins. The line labeled ÒAÓ is the loop start point. The line
labeled ÒBÓ is the loop end point.

1.  Loop start and end points 
are placed at the best sounding 
positions in the soundfile.

2. Data near the loop end 
point is tapered (faded out).

3. A section of data just 
before the loop start point is 
copied and tapered (faded in) 
to create the transition data 
segment.

4. The transition data is 
added to the loop end data to 
create a smoother return to the 
loop start.
INFINITY UserÕs Manual 19
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Used with skill and patience, crossfade looping techniques can result in
marginally usable loops in some non-periodic sounds. The level of quality
that results is currently considered acceptable, but is, in fact, mediocre com-
pared to what can be achieved by INFINITYÕs unique DSP tools.

The Costs Of Current Methods

The time and effort required to make a good set of looped samples is more
than most musicians are willing to invest. With complex sounds like pianos,
string sections, chorused synths, and so on, it is extraordinarily difÞcult to
make good crossfade loops. Lumpy loops have necessarily become accept-
able.

The third party sound design business is booming. License to use pre-
looped sounds which are often of less than satisfactory quality costs hun-
dreds of dollars. While this saves time and effort, even the best commercial
samples have audible loops. 
nual



  

The INFINITY Environment

Title Bar

Close Box

Overview

View Indicator

Vertical Annotation

Mainview

Horizontal Annotation

Playback 
Position Pointer

Track Divider

MIDI Note Number
The INFINITY Environment 

Even experienced sound designers are advised to read this section carefully.
It contains basic information on the display and manipulation of digital
sound that is essential to using INFINITY.

The SoundÞle Window 

The soundÞle window is a visual representation of the soundÞle on the
desktop. Much of the work you do on the soundÞle will be done inside the
soundÞle window. The soundÞle window has several components whose
functions are listed below. 

Zoom Box

Loop Point Grow Box
INFINITY UserÕs Manual 21
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Title Bar

The Title Bar contains the name of the soundÞle, the close box, the zoom
box, and either ÒNo BackupÓ or ÒBackup CreatedÓ written next to the title
of the soundÞle. 

INFINITY will create a backup Þle when the soundÞle is Þrst opened pro-
vided the corresponding PreferencesÉ dialog item is enabled. When
ÒBackup CreatedÓ is displayed in the title bar, the Revert to Backup com-
mand can be used in the File Menu. See ÒCreate Backup FilesÓ on page 55.

Close box

Clicking on the close box will close the soundÞle window. 

Zoom box

Clicking on the zoom box will increase the size of the window to the maxi-
mum allowed by the size of your video monitor. Clicking it again will
return the window to its original size.

Overview

The Overview displays the whole soundÞle, the insertion point, loop
points, and the Playback Position Pointer. The Overview allows you to nav-
igate around the soundÞle easily. In a stereo soundÞle, the left track is dis-
played above the right track. 

Data can be chosen for display in the Mainview by using the view indicator
described below. Data can also be selected in the Overview by placing it in
the Selection Mode using the Palette. See ÒUsing Selection Mode In The
OverviewÓ on page 40 for details of how this is done.

View Indicator 

The view indicator is a dotted rectangular box which shows the borders of
the region of the soundÞle which is currently displayed in the Mainview.
Any change in the Mainview is reßected by a change in the view indicator.
The region displayed in the Mainview can be changed by redrawing the
view indicator. The details are discussed in ÒUsing Zoom Mode In The
OverviewÓ on page 33.
nual
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Playback Position Pointer

The Playback Position Pointer appears in both the Overview and the Main-
view. It is a non-blinking vertical line with terminals at each end that moves
across the screen as the soundÞle plays. It shows where playback is occur-
ring so that you can correlate the sound and the graphic display of the
soundÞle. 

Vertical Annotation

The Vertical Annotation allows you to measure the amplitude of the wave-
form in the Mainview. The units displayed are either per cent of full scale or
decimal sample values. The units for the Vertical Annotation are chosen in
the PreferencesÉ dialog. The Vertical Annotation and the soundÞle data
can be moved up or down by using the vertical scroll bar when the scale is
expanded.

Mainview

The Mainview always displays the part of the soundÞle shown in the view
indicator in the Overview. When a Þle is opened, the Mainview initially dis-
plays the whole soundÞle. The amount of data displayed in the Mainview
can be changed by redrawing the view indicator in the Overview, or by
using the Display Scale Icon on the Palette. The Mainview can also be
placed in the Zoom Mode. See ÒUsing Zoom Mode In The MainviewÓ on
page 34. The data in the Mainview can be scrolled using several methods.
See ÒScrolling The SoundÞle DataÓ on page 32.

Track Divider and Zero Crossing

The tracks in both the Overview and the Mainview can be separated by a
track divider line. There can also be a dotted zero crossing line in each chan-
nel. These choices are made in the PreferencesÉ Dialog. See ÒCustomizing
The SoundÞle WindowÓ on page 56.

The Horizontal Annotation

The Horizontal Annotation is located below the Mainview and runs the full
width of the window. It allows you to measure time in the soundÞle. The
units for the Horizontal Annotation are selected in the PreferencesÉ dialog.
There are three display formats: Samples, Time, and SMPTE formats. 
INFINITY UserÕs Manual 23
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Loop Points

The Loop Points show the region of data in the soundÞle that will be looped
when the soundÞle is played. The Loop Points can be moved by dragging
them horizontally. They can also be dragged during sound playback.

Loop Points can be created by selecting the Create Loop Points menu item
in the Edit menu or by clicking on the Loop Points Icon on the Palette. The
Loop Points can be deleted by clicking on the Loop Points Icon or by select-
ing the Delete Loop Points item in the Edit Menu.

Grow Box

Dragging the grow box allows you to resize the window.

The Palette

The Palette is always present on the desktop. It contains information and
tools for editing the soundÞle data. It is divided into three sections; 
∞ the Mode Icons , 
∞ the Status Display , and
∞ the Action Icons . 

The area in the middle of the Palette is the Status Display. It is used for ver-
bal messages and as a cursor tracking display. The icons above the Status
Display are the Mode Icons. The icons below the Status Display are the
Action Icons. Icons which cannot be selected are grayed out.

Mode Icons

Status Display

Action Icons

Pressing on the 
Palette in an 
area where 
there are no 
icons reveals the 
key command 
equivalents for 
the icons.
nual



The INFINITY Environment
The Palette can be dragged anywhere on the desktop by pressing on the
grey bar at the top of the Palette and dragging it to the desired location.
Pressing on the Palette in an area where there are no icons will reveal the
keyboard equivalent commands for the icons.

Mode Icons

When INFINITY starts, the Mainview is in Selection Mode and the Over-
view is in Zoom Mode. The mode of a display determines what work can be
done on the data in that display. See ÒUsing Zoom Mode In The MainviewÓ
on page 34 and ÒUsing Selection Mode In The OverviewÓ on page 40 for
instructions on changing the mode of a display.

The mode icons are:

∞ Selection Mode Icon: Selection Mode allows data to be selected in the
display. See ÒSpecifying Where To Change Sound DataÓ on page 38.

∞ Zoom Mode Icon: Zoom Mode allows speciÞcation of a region to be dis-
played in the Mainview. See ÒChanging The Display ResolutionÓ on
page 33.

Status Display

The Status Display on the Palette gives information about the location of
the cursor. Four Þelds of information are displayed which show various
Þelds, depending on the current usage of the software:

∞ Track : This Þeld displays the track where the cursor is located.

∞ C: This Þeld displays the absolute time at the cursor location.

∞ Amp : This Þeld displays the vertical location of the cursorÕs active pixel.

∞ C-I : This Þeld displays the horizontal position of the cursor relative to
the insertion point when the insertion point is present. 

During a selection, this Þeld reads ÒSelect:Ó and shows how much data
has been selected.

When the loop points are being dragged and the cursor is in the Main-
view, this Þeld reads ÒLoop:Ó and displays the amount of data inside the
loop.
INFINITY UserÕs Manual 25
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When the cursor is in the sound view of the Crossfade Looper, this Þeld
reads either ÒSide: Loop StartÓ or ÒSide: Loop EndÓ depending on which
side the cursor is located.

The Action Icons

∞ The Speaker Icon is used to play the soundÞle. If a region is selected,
only that region will play. See ÒUsing The Speaker IconÓ on page 37.

∞ The Display Scale Icon is used to change the display resolution of the
Mainview. See ÒUsing The Display Scale iconÓ on page 33.

∞ The Fit Selection Icon Þlls the Mainview completely with the currently
selected region. See ÒUsing The Fit Selection IconÓ on page 33.

∞ The Loop Points Icon creates or deletes loop points in a soundÞle. See
ÒCreate/Delete Loop PointsÓ on page 47.

∞ The Loop Start Icon scrolls the Mainview so that the Loop Start point is
in the center of the screen. See ÒLocating Loop PointsÓ on page 47.

∞ The Loop End Icon scrolls the Mainview so that the Loop End point is in
the center of the screen. See ÒLocating Loop PointsÓ on page 47.
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Get InfoÉ

Keyboard Equivalent Command: -I. Selecting Get InfoÉ will cause the
Information dialog shown above to appear. It contains information on the
currently active soundÞle. Data cannot be edited in the Information dialog.

Sound File refers to the title of the active soundÞle.

File Type  refers to the Þle format in which the soundÞle is stored.

Tracks  refers to the number of data channels that exist in the Þle: one track
for mono Þles, two tracks for stereo Þles.

Duration  of the Þle is given in the current time format. 

Sample Rate  refers to the sample rate of the soundÞle. 

File Size  of the soundÞle is shown in kilobytes. 

Unused HD  states the amount of empty space that is currently available on
the hard disk of the currently active soundÞle. 
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Disk Based Files

Unlike most Macintosh applications which store their open Þles in RAM,
INFINITY uses disk based Þles. Changes made to the soundÞle are auto-
matically written to the disk when the change is made. SoundÞles, how-
ever, are played and processed from RAM. If a Þle is too large to Þt in RAM,
you can select and play a smaller portion.

Envelope Files

In order to display a soundÞle, INFINITY creates an envelope Þle. These
Þles are stored in a folder called Ò envelope FilesÓ in the same folder as the
sound Þle. Envelope Þles are used to store information which allows
INFINITY to quickly draw the soundÞle on the screen. They occupy about
one tenth the disk space that the soundÞle uses and are stored in a special
Envelope Folder which INFINITY creates. Envelope Þles are saved in the
Envelope Folder after the soundÞle is closed.

When data in the soundÞle is shifted as a result of an edit, the envelope is
also shifted, hence avoiding more lengthy computations involving the
soundÞle. Unfortunately, the envelope can only be shifted to an accuracy of
± 10 samples. Hence, the envelope may be slightly inaccurate. In this cir-
cumstance a ÒstaleÓ ßag is set in the envelope Þle.

Only the Þrst envelope is shifted. The remaining envelops are recomputed
from the Þrst envelope. This means the remaining envelopes will have
fewer errors. SpeciÞcally, each envelope frame (sample) will contain errors
of up to ten sound samples, however the second, third, fourth, etc. enve-
lopes represent 400, 8000, 160,000, etc. sound frames each. Thus, the worst
error will be 10 out of 400, 10 out of 8,000, 10 out of 160,000, etc.
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The next time the soundÞle is opened, the ÒstaleÓ ßag is checked, and if the
Þle is sufÞciently large, the following message appears:

Choosing either command button will reset the ÒstaleÓ ßag and the mes-
sage will not reappear until the next edit. 

When a soundÞle is opened, if the envelope Þle is not found or if the sample
counts donÕt agree with the envelope frame count, then the envelope Þle is
recomputed automatically. If the soundÞle has been modiÞed by some
other sample editing program, the envelope is considered to be Òout of
dateÓ. If this Òout of dateÓ condition exists, and the Þle is sufÞciently large,
the dialog shown above is posted. If ÒRecomputeÓ is chosen, the envelope is
recomputed. If ÒUse OldÓ is chosen, then the envelope Þle is touched so the
condition does not reoccur, and no prompt will occur for the ÒstaleÓ condi-
tion, even though the envelope Þle may be stale.

Backup Files

If the Create Backup Files function in the PreferencesÉ dialog is enabled, a
backup Þle is created when a soundÞle is opened. Upon closing a soundÞle,
the backup Þle is deleted. Note that other temporary Þles are created as a
result of edit operations involving the Clipboard and undo-able edits. These
are automatically managed by INFINITY.
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Balloon Help

INFINITY incorporates sophisticated on-line help using AppleÕs System 7
Balloon Help feature. Click on Show Balloons in the menu to turn on
Balloon Help.

Balloon help is available for 
every item in INFINITY’s 
user interface. Some items 
have graphics to explain 
complex processes.
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CHAPTER 3 INFINITY Basics
Press <Command> - X
to perform a cut.
This chapter will introduce you to the basic functions of INFINITY. We rec-
ommend that you read through this chapter once and then refer to it as
needed while becoming familiar with INFINITY.

Using Commands

Using Keyboard Command Equivalents
The keyboard can be used to choose many commands. If a command has a
keyboard equivalent, it usually appears on the menu or on the Palette.

Pressing <shift-option>
will temporarily put
INFINITY into
Selection Mode.

Pressing the <space bar>
actuates the Speaker icon.
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The shift, option, command ( ), and control keys are called modiÞer keys.
They donÕt do anything by themselves, but they can modify the next key-
stroke or mouse click. In INFINITY, they are also used in combination to
momentarily put the program in either Selection Mode or Zoom Mode. For
details of how this is done, see ÒUsing Momentary Selection ModeÓ on
page 40 and ÒUsing Momentary Selection ModeÓ on page 40.

The following are examples of keyboard command equivalents and instruc-
tions on how to execute them. For a full listing of all the keyboard com-
mand equivalents.

To execute: Do this:

-X Hold down the <command> key and press X.

shift-opt. Press the <shift> and <option> keys at the same time.

shift- -[ Hold down the <shift> and <command> keys and press [.

Undoing A Command
Commands which change the soundÞle can be undone by choosing Undo
from the Edit menu. The keyboard command equivalent is -Z. 

This function is possible only if Enable Undo is checked in the Prefer-
encesÉ dialog. See ÒEnable UndoÓ on page 55.

Viewing The Soundfile

After you open or create a soundÞle, INFINITY allows the soundÞle to be
viewed in a variety of ways designed to increase the speed and ease of edit-
ing the data. This section explains how to scroll the data, change the magni-
Þcation of the display, and manage multiple windows.

Scrolling The SoundÞle Data
INFINITY provides several convenient options for scrolling the soundÞle
data in the Mainview. The soundÞle data can be scrolled both horizontally
and vertically. 
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To: Do this:

Scroll by small increments Click on an arrow in a scroll bar, or press
the appropriate arrow key.

Scroll by one window increments Click on a grey area in a scroll bar, or press
<shift> and the appropriate arrow key.

Scroll full left and center vertically. Press the <Home> key.

Changing The Display Resolution

Using The Display Scale icon

The display resolution of the Mainview can be changed by using the
Display Scale icon on the Palette or the keyboard command equivalents. 

To: Do this:

Double the vertical display resolution Click on the up arrow or press . 

Halve the vertical display resolution Click on the down arrow or press . 

Double the horizontal display resolution Click on the right arrow or press .

Halve the horizontal display resolution Click on the left arrow or press .

Zoom to the extreme setting Press <option> and click on the appro-
priate arrow or press the appropriate 
arrow key.

Using The Fit Selection Icon

Clicking on the Fit Selection icon will cause a selected region to Þll the
Mainview Display. The keyboard command equivalent is -F.

Using Zoom Mode In The Overview

When a soundÞle is opened, the Overview is in Zoom Mode. In Zoom
Mode, a view indicator can be dragged around the area of the soundÞle you
want to see in the Mainview. This area then Þlls the Mainview display.

To chose an area of the soundÞle for viewing in the Mainview:

1. Move the cursor into the Overview display.
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The cursor turns into a cross. The Zoom icon on the Palette video-
reverses to show that this display is in Zoom mode.

2. Place the cursor at the corner of the area you want to display and then click-drag 
the mouse over the area. 

A view indicator box appears around the area you have chosen.

3. Release the mouse.

The view indicator remains around the area you have chosen. The Main-
view now displays the selected area.

Using Zoom Mode In The Mainview

The view indicator can be used directly in the Mainview itself, by placing
the Mainview in Zoom Mode. 

To put the Mainview in Zoom Mode:

1. Click on the Zoom Mode icon in the Palette.

The icon begins to blink and the message ÒChoose a Window for Zoom
ModeÓ appears in the Status Display area of the Palette.

2. Move the cursor into the active window and click in the Mainview.

The cursor becomes the cross cursor. The Zoom Mode icon on the Palette
video-reverses to show that the Mainview is in Zoom Mode. 

You may now drag a view indicator around any region in the Mainview.
The display will automatically scroll if the view indicator is dragged past
the edge of the display. The view indicator can also be dragged from the
Þrst click inside the Mainview.

To put the Mainview back into Selection Mode,

1. Click on the Selection Mode icon in the Palette.

The icon begins to blink and the message ÒChoose a Window for Selec-
tion ModeÓ appears in the Status Display area of the Palette.

2. Move the cursor into the active window and click in the Mainview.

The cursor becomes the I-beam cursor. The Selection Mode icon on the
Palette video-reverses to show that the Mainview is in Selection Mode. 

You may now select data in the Mainview as before.
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Using Momentary Zoom Mode 

INFINITY can be put into Zoom Mode temporarily by pressing <control-
shift>. This is useful for quickly zooming a region in the Mainview. The cur-
sor will become the cross cursor and all active displays will remain in Zoom
Mode as long as this key combination is pressed. When the key combina-
tion is released, all displays go back to their previous modes.

Using Full Zoom In and Full Zoom Out

The horizontal display resolution of the Mainview can be set to its extreme
in one step.

To: Do this:

To zoom to minimum resolution Select Full Zoom Out from the Display menu, or 
double-click on the Mainview in Zoom Mode.

To zoom to maximum resolution Select Full Zoom In from the Display menu.

Changing Separators, Units and Scales

Show Zero Crossing 

This item places dotted lines at the zero crossing of tracks in the Overview
and Mainview. 

Show Track Dividers

When checked, this item places solid lines between the tracks in the Over-
view and Mainview. 

Vertical Scale Units

This item allows either percentage of full scale or sample value to be dis-
played on the Vertical Annotation in the Mainview and the Status Display
Area of the Palette. 
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Horizontal Scale Units

This item allows the units shown on the Horizontal Annotation of the
Mainview and all other time displays to be chosen. The pop-up menu
choices are Samples, Hours:Minutes:Seconds:Milliseconds, SMPTE 24 FPS,
SMPTE 25 FPS, SMPTE 30 FPS, and SMPTE 30 FPS Drop. 

Managing Multiple Windows 

Windows can be arranged by using the Tile Windows and Stack Windows
commands in the Windows menu.

To: Do This:

Show all open windows without overlapping Select Tile Windows.

To stagger all open windows at maximum size Select Stack Windows.

Hiding The Overview

More space in the active soundÞle window can be created by using the
Hide Overview command in the Display Menu. Selecting this command
causes the Overview of the active window to disappear. When the active
window has its Overview hidden, the menu item reads ÒShow OverviewÓ.
Selecting Show Overview will put the Overview back in the active window.

Listening to The Soundfile

Setting-up Sound Playback
The Sound Playback menu contains a list of the devices which are currently
installed. Choosing an item will direct the soundÞle playback through the
selected device. Choosing Mac 8, or Mac 16 connects INFINITY the Apple
Sound Manager. 'Mac 8 bit' presents 8 bit data to the Sound Manager and
'Mac 16 bit' presents 16 bit data to the Sound Manager.   (The Sound Man-
ager 3.0 or later must be present.  If not, 'Mac 16 bit' will present 8 bit data to
the Sound Manager.)  Interpolation of data occurs when the sample rate of
the Mac is different than the sample rate of the data.  The Sound Manager
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distorts the sound when there are not enough machine cycles to interpolate
the data.  If this occurs, there are two things to try.  The Þrst is to use 'Mac 8
bit', since the Mac is faster at interpolating 8 bit data.  The second is to set
the sample rate of the Mac to the Sample rate of the data.  See the Sound
control panel to adjust Sound Manager sample rates.

Playback Auto-Reset
If this item is checked, playback will occur from the beginning of the sound-
Þle unless a region is selected. If this item is not checked, playback will
begin from the point where it stopped the last time. This item should
remain checked for most applications.

Scroll After Playback
This item is initially not checked when you start INFINITY. Checking this
item causes the Mainview to automatically scroll to the position where
playback stopped. This feature is most useful when working with the Main-
view at high display resolutions.

Using The Speaker Icon
The soundÞle can be played by clicking on the Speaker icon in the Palette.
Click the icon again to stop playback. Pressing on the <space bar> is the
keyboard command equivalent for the Speaker icon. Playback in the active
soundÞle window is determined by the following conditions:

If: Then:

No data is selected The track(s) containing the insertion 
point play from the beginning of the 
soundÞle.

The soundÞle has loop points The track(s) containing the insertion 
point are played from the beginning and 
continue to loop until the Speaker icon is 
clicked again.

Data is selected Just the selected region is played.
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The selection contains both loop points The selection is played and loops until 
the Speaker icon is clicked again.

Only the loop data is selected Just the loop will play until the Speaker 
icon is clicked again.

A looping tool is the active window Both tracks of the soundÞle are played 
from the beginning regardless of any 
insertion point or selection.

Note: In a stereo soundÞle, data is played back through the audio channel that cor-
responds to the track number. Data on Track 1 plays through the Left channel; data
on Track 2 plays through the Right channel.

Editing The Soundfile

In addition to automated looping tools, INFINITY has a sophisticated
waveform editing environment. The following section describes how to
select data and use the editing tools to change it.

Specifying Where To Change Sound Data
The Þrst step in editing the soundÞle data is to identify which data are to be
changed. In INFINITY, as in many other Macintosh applications, data is
selected by using the insertion point and the I-beam cursor. Data can be
selected in both the Overview and the Mainview. 

Using Selection Mode In The Mainview

When a soundÞle opens, the Mainview is in Selection Mode. Selection
Mode is used to change the current selection or insertion point. When the
cursor is moved into the active Mainview display, it becomes the I-beam
cursor. The Selection icon on the Palette video-reverses to indicate that the
Mainview is in Selection Mode. The I-beam cursor can be used to place the
insertion point or make a selection anywhere in the soundÞle.

Placing The Insertion Point

The insertion point is the blinking vertical line which appears in both the
Overview and the Mainview. It can be moved only in Selection Mode by
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using the I-beam cursor. It marks the place where data will be inserted or a
boundary of a region to be selected.

To: Do This:

Place the insertion point Click once in the Mainview at the desired 
location. In a stereo soundÞle, the insertion 
point appears in both tracks.

Place it in only one track Hold down the <option> key and click at the 
desired location.

Extend it to the other track Hold down the <control> key and click in the 
other track. Click again to remove it.

Selecting Data 

There is a variety of ways to select data in INFINITY. Selected data become
video reversed to show that they are selected. The Mainview will automati-
cally scroll during the selection if the cursor is dragged beyond the data dis-
played in the Mainview.

To: Do this:

Select a region in one track Drag through the region, or <option>click at 
the start , then <shift>click at the end.

Select a region in both tracks Drag across the two tracks, or click at the 
start of the region, then <shift>click in the 
other track at the end.

Lengthen the selection Point at the new start or end and <shift> 
click. You can then drag to a different end-
point.

Shorten the selection Point near the current end, <shift>click, 
then drag to a different endpoint. 

Extend the selection to the other track Hold down the <control> key and click in 
the other track. Click again to remove it.

Select a whole track Double-click in the track; or place the 
insertion point in the track and choose 
Select All ( -A) from the Edit menu.

Select all the data in the soundÞle Double-click in one track and drag to the 
other; or <shift>double-click in the other 
track; or place the insertion point in both 
tracks and choose Select All ( -A) from 
the Edit menu.

Select the data inside the loop points Choose Select Loop ( -L) from the Edit 
menu.
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Deselect a region Place an insertion point anywhere.

Using Selection Mode In The Overview

Data can also be selected in the Overview by placing the Overview in Selec-
tion Mode. The insertion point and data selection behaviors are exactly the
same as in the Mainview.

To put the Overview in Selection mode:

1. Click on the Selection icon in the Palette.

The icon begins to blink and the message ÒChoose a Window for Selec-
tion ModeÓ appears in the Status Display area of the Palette.

2. Move the cursor into the active window and click in the Overview.

The cursor becomes the I-beam cursor. The Selection icon on the Palette
video-reverses. Use the I-beam cursor to select any region in that Over-
view.

To put the Overview back into Zoom Mode,

1. Click on the Zoom Mode icon in the Palette.

The icon begins to blink and the message ÒChoose a Window for Zoom
ModeÓ appears in the Status Display area of the Palette.

2. Move the cursor into the active window and click in the Overview.

The cursor becomes the cross cursor. The Zoom Mode icon on the Palette
video-reverses to show that the Overview is in Zoom Mode. 

Using Momentary Selection Mode 

INFINITY can be put into Selection Mode temporarily by pressing <shift-
option>. This is useful for quickly selecting a region in the Overview. The
cursor will become the I-beam cursor and all active displays will remain in
Selection Mode as long as this key combination is pressed. When the key
combination is released, all displays go back to their previous modes.
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Using The Editing Functions

This section describes the edit functions shown in the Edit menu as they
operate without the use of the Blending feature. See ÒUsing Edit BlendingÓ
on page 50 for the details of how this feature effects the edit functions. 

All of the functions described below can be reversed using the Undo com-
mand in the Edit menu, provided that Undo is enabled in the PreferencesÉ
dialog. See ÒCustomizing Your EnvironmentÓ on page 55 for the details.

When an edit operation is done on a soundÞle, the contents of the Clip-
board is stored as the soundÞleÕs Òprevious ClipboardÓ. For a Cut or Copy,
the following steps take place:

∞ The application Clipboard is updated.

∞ The soundÞle stores the new Clipboard as itÕs Ònew ClipboardÓ.

∞ For a Clear, Clear Unselected, or Paste, the soundÞle stores Òundo infor-
mationÓ to undo the edit.

∞ You can go back to any document, any time after it has been edited, and
do an undo.

∞ The soundÞle uses the Ònew ClipboardÓ or the Òundo informationÓ,
whichever is available, to undo the edit.

∞ If the soundÞleÕs Ònew ClipboardÓ information was used, and if that
information is the same as the application Clipboard, then the applica-
tion Clipboard is replaced with the soundÞleÕs Òprevious ClipboardÓ. 

∞ This has the effect of undoing the Clipboard as well as the soundÞle edit.

∞ You can go back to any document, any time after it has had an ÒundoÓ
and do a ÒredoÓ.

∞ If the ÒundoÓ had the effect of undoing the Clipboard, then ÒredoÓ will
have the effect of restoring it.

Cut

Cut removes precisely the number of samples that are selected. Any data to
the right of the cut is shifted left by exactly that amount. Blending is per-
formed by combining data just inside the selection with data that was not
cut on the opposite end of the selection. Hence, if you use cut to remove a
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noise spike, you may Þnd, depending on the size of the cut and the amount
of blending used, that part of the spike still remains.

If an ÒUndo CutÓ occurs later, the cut data is replaced in the soundÞle and
the previous Clipboard data is returned to the Clipboard.

∞ To cut data, select the data to be removed. Then choose Cut from the
Edit menu. The keyboard command equivalent is -X.

Copy

The Copy function copies data into the Clipboard without removing it from
the soundÞle. Since the Clipboard can hold only one item at a time, any
data previously in the Clipboard is lost.

∞ To copy data, select the region to be copied. Then select Copy from the
Edit menu. The keyboard command equivalent is -C.

Paste

The Paste function inserts data from the Clipboard into the soundÞle.
INFINITY will paste data into the soundÞle at the insertion point or replace
a selected region with the Clipboard data. Since the original data remains
on the Clipboard, it can be pasted any number of times. The keyboard com-
mand equivalent is -V.

When Pasting into a soundÞle that has no samples, the soundÞle will
acquire the sample rate and MIDI Note Number of the Þrst data pasted into
it.

Normally, when Pasting or Mixing with an insertion point, the new data is
inserted before the Þrst sample of the group of samples represented by the
pixel under the insertion point. The exception to this rule is when the inser-
tion point is on the last pixel in the soundÞle window. In that case, the new
data is added after the last sample in the soundÞle. Blending occurs
between the end of the original sound and the pasted data. 

∞ To paste at the insertion point, place the insertion point where the region
of pasted data is to begin. Then select Paste from the Edit menu. The
data to the right of the insertion point is moved over and the Clipboard
data is inserted.
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∞ To replace a selected region with the Clipboard, select the region to be
replaced. Then select Paste from the Edit menu. The selected data is
deleted and the Clipboard data is inserted in its place. Data to the right
of the selection is moved to Þt the newly pasted region.

Attempting to paste a stereo Clipboard into one track, evokes this dialog.

Attempting to paste a mono Clipboard into two tracks, evokes this dialog.

Clear

The Clear function is the same as Cut except the Clipboard remains
unchanged. The data to the right of the cleared region are moved to Þll up
the gap.

∞ To clear data, select the region to be cleared. Then select Clear from the
Edit menu. The keyboard command equivalent is -B or <delete>.
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Clear Unselected

The Clear Unselected function clears all the data around a selected region of
the soundÞle. After the unselected data are cleared, the selected region is
moved to the front of the soundÞle. 

∞ To clear unselected data, select the region to be left unchanged. Then
choose Clear Unselected from the Edit menu. The keyboard command
equivalent is -T.

Clear Beyon Loop End

This option clears data after the loop.

Mix

The Mix function combines the contents of the Clipboard with the soundÞle
data in a 1:1 ratio. INFINITY will mix data into the soundÞle starting at the
insertion point or mix into a selected region. The keyboard command
equivalent is -M. There must be data in the Clipboard for the Mix func-
tion to be enabled. You can mix into a selection or at an insertion point.

∞ To mix data starting at the insertion point, place the insertion point
where the mixture is to begin. Then select Mix from the Edit menu. The
data in the Clipboard will be mixed with the soundÞle in a 1:1 ratio,
starting at the insertion point and going to the end of the Clipboard.
When mixing to an insertion point, the Clipboard selection is placed at
the insertion point. Initial blending (if enabled) occurs before the inser-
tion point. After the insertion point, all of the Clipboard is mixed, even if
this means extending the length of the soundÞle.

∞ To mix data into a selected region, choose Mix from the Edit menu. The
Clipboard is mixed with the selected data from the beginning of the
selection through the duration of the Clipboard or the selected region,
whichever is shorter. When mixing into a selection (with no blend), the
mixed data is limited to the minimum of the soundÞle selection or the
Clipboard selection. This keeps changes within the selection.

When there is a blend, the blend is done outside the selection and different
blends are used for beginning and end, whatever can be worked out
between the soundÞle and the Clipboard.
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In blending during the mix, the soundÞle is never tapered. The Clipboard is
tapered up in the beginning and down at the end (depending on the
amount of data available to construct the blend).

When mixing into a soundÞle that has no samples, the soundÞle will
acquire the sample rate and MIDI Note Number of the Þrst data pasted or
mixed into it.

Normally, when Pasting or Mixing with an insertion point, the new data is
inserted before the Þrst sample of the group of samples represented by the
pixel under the insertion point. The exception to this rule is when the inser-
tion point is on the last pixel in the soundÞle window. In that case, the new
data is added after the last sample in the soundÞle. 

Invert

The Invert function changes the sign of the soundÞle data. In other words, it
inverts the ÒphaseÓ of the waveform by 180 degrees. 

∞ To invert the soundÞle data, select the region to be inverted. Choose
ÒInvertÓ from the Edit menu. The selected data are then changed.

Reverse

The Reverse function reverses the order of the sample data in time, end for
end. (e.g. a backwards cymbal roll)

∞ To reverse the soundÞle data, select the region to be reversed. Choose
ÒReverseÓ from the Edit menu. The data are then switched in order, the
last sample coming Þrst.

Silence

The Silence function zeroes selected data in the soundÞle.

∞ To silence soundÞle data, select the region to be silenced. Choose
ÒSilenceÓ from the Edit menu. The sample values of the selected data are
then zeroed.
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Normalize

The Normalize function increases the gain of a selected region until the
largest sample in the region is at 100% amplitude. Normalize insures the
maximum signal to noise ratio from your sample playback instrument.

∞ To normalize soundÞle data, select the region to be normalized. Choose
ÒNormalizeÓ from the Edit menu. The selected region will be increased
in amplitude until the largest sample in the region is at full scale.

Change GainÉ

The Change Gain dialog allows the level of the soundÞle to be adjusted to
avoid clipping during processing. Selecting Change GainÉ from the Edit
menu will cause the following dialog to appear.

The gain of the selected data can be changed by using the slider or by typ-
ing in the text box. The range of the control is from -12 dB to +12db. Click-
ing on the arrows will increment the setting by 1 dB. Clicking in the grey
area will increment the setting by 3 dB.

A typical application for the Change Gain function is adjusting the level of a
normalized soundÞle downwards before mixing it with another soundÞle.
After processing, the soundÞle can be returned to its original level by
changing the gain an equal amount in the opposite direction.

∞ To change the amplitude of soundÞle data, select the data to be scaled.
Choose Change GainÉ from the Edit menu. Set the desired gain change
using the controls. Click OK to process the data. Changing Gain can be
undone.
nual



Editing The SoundÞle
Create/Delete Loop Points

The Loop Points icon adds loop points to a Þle or deletes them from a Þle
which has them.

∞ To create loop points in a soundÞle, click on the Loop Points icon in the
Palette, or choose Create Loop Points from the Edit menu. The keyboard
command equivalent is -P. The loop points appear in the soundÞle
and the menu item changes to read Delete Loop Points. 

∞ To delete loop points from a soundÞle, click on the icon again. The loop
points will disappear and the menu item will change back to read Create
Loop Points. The deleted loop points can be returned to their original
positions by clicking on the icon a third time.

Loop the selection

This command place the loop points at the ends of the current selection.

Locating Loop Points

The Mainview can be scrolled to the position of either the loop start or loop
end points. The Loop Start icon is labeled 1. The Loop End icon is labeled 2.

∞ To center the Mainview on the loop start point, click on the Loop Start
icon. The keyboard command equivalent is -shift -[.

∞ To center the Mainview on the loop end point, click on the Loop End
icon. The keyboard command equivalent is -shift-].

Hold the Option key while clicking these buttons does a full zoom out of
the mainview display.
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Positive Going
Zero Crossing
Set MIDI NoteÉ

Choosing this item from the Edit menu or clicking on the MIDI Note Num-
ber in the soundÞle window displays the following dialog.

The MIDI Note Number tells INFINITY the pitch of the soundÞle. It is used
in INFINITYÕs looping algorithms and is critical to the operation of the
Freeze Looper. Empty soundÞles will acquire the sample rate and MIDI
Note Number of the Þrst data pasted or mixed into them.

∞ To change the MIDI Note Number, choose Set MIDI NoteÉ from the
Edit menu. Data can be entered by typing in the text box or by using the
scroll bar. Either the MIDI Note Number or the musical pitch (e.g. C#3)
can be entered. Clicking in the grey area increments by one octave. 

Auto-Zero

When this item is checked in the Edit menu, INFINITY constrains the
boundaries of selected regions to positive going zero crossings in the sam-
ple data. This helps you to avoid creating pops and clicks when you cut and
paste. INFINITY will always expand the selection to the positive going zero
crossings closest to the initial selection boundaries. When two tracks are
selected, Track 1 is used as the guide track.
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Editing The SoundÞle
∞ To constrain the selection boundaries to positive going zero crossings in
the soundÞle, check Auto-Zero.

Show ClipboardÉ

Choosing Show ClipboardÉ in the Edit menu calls the following dialog.

The dialog gives information about what data is currently in the Clipboard. 

Source Sound File : The name of the soundÞle from where the current
Clipboard contents originated.

Selection Size : The size of the selected region in terms of the currently
selected units used in the Horizontal Annotation. (in this case, samples)

Track Count : The number of tracks in the Clipboard.

Sample Rate : Expressed in Hertz

Begin Blend Size : The number of samples (or duration) before the
selected region which will be used to blend the region when pasting or
mixing.

End Blend Size : The number of samples (or duration) after the selected
region which will be used to blend the region when pasting or mixing.

Sound data which has been copied into the Clipboard in INFINITY cannot
be shared with Sound Designer or Alchemy, as these programs have incom-
patible Clipboard formats. 
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Using Edit Blending

Enabling the Blending function causes INFINITY to blend the edges of data
segments that are moved during Cut, Paste, Clear, Mix, Invert, Reverse,
Silence, Normalize, and Change Gain operations. This smooths the transi-
tion so that abrupt changes in the sound are avoided. The following Þgures
show the effect of blending as used with the Cut and Clear functions.

The illustration below describes the effect of Blending on the Paste function. 

Selected 

Blend Taper

Blend Time

1. Select a region of data.

4. The data on the right are 
moved to close the gap and 
are crossfaded with the 
data on the left.

3. Data on both sides of the 
selection boundaries are 
tapered. The remaining 
selected data are removed 
from the soundfile.

2. Choose either Cut or 
Clear from the Edit Menu.

Region

1. Place the insertion point 
at the location where data is 
to be pasted.

2. Select Paste from the 
Edit menu.

3. Data on either side of the 
insertion point is tapered. 
The data on the right are 
moved to create a gap to fit 
the Clipboard data.

4.Clipboard data are 
tapered and crossfaded 
with the soundfile data. 

Insertion Point

Clipboard Data

Clipboard Selection Size
l



Editing The SoundÞle
A Cut or Copy will put the selected data in the Clipboard. If blending is
enabled and the blend time is greater than zero, the leading and trailing
samples will also be put on the Clipboard. If the selected region is at the end
of a Þle, fewer or no trailing samples will be captured. If the selected region
is at the beginning of a Þle, fewer or no leading samples will be captured.
You can see how many leading and trailing samples are captured with
ÒShow ClipboardÓ. These are labeled ÒBegin Blend SizeÓ and ÒEnd Blend
SizeÓ, respectively.

A Paste will similarly identify independent leading and trailing blend
regions around the selection or insertion point. Paste will then compare its
leading blend region with the leading blend region of the Clipboard and
choose the smallest. Similarly, for the trailing blend time. The Paste is then
performed with these new blend times. Note that blending occurs outside
of the original selection and outside of the PasteÕs selection.

A Cut removes precisely the number of samples selected in the Þle. In order
to blend the result, samples on both side of the beginning of the selection
are merged with samples on both sides of the ending selection, provided
that blending is enabled and there is a non-zero blend time. The size of the
merge is given by the blend time. It must be noted, therefore, that cutting
some samples does not necessarily completely remove them. To completely
remove the center-most samples, the selection size must be larger than the
blend time.

Clear Unselected does no blending.

Clear is the same as Cut, except no samples go to the Clipboard. Blending in
Clear works the same as blending in Cut.

Normally, when Pasting or Mixing with an insertion point, the new data is
inserted before the Þrst sample of the group of samples represented by the
pixel under the insertion point. The exception to this rule is when the inser-
tion point is on the last pixel in the soundÞle window. In that case, the new
data is added after the last sample in the soundÞle. Blending occurs
between the end of the original sound and the pasted data. 
INFINITY UserÕs Manual 51



INFINITY Basics

52 INFINITY UserÕs Ma
Adjusting The Blend Parameters

INFINITY allows the length and taper of the crossfade used in edits to be
adjusted. Clicking on the BlendÉ command button in the PreferencesÉ
dialog will evoke the Edit Blend Settings dialog shown below.

Blend Time
To change the length of the crossfade, use the Blend Time scroll bar or type
directly into the text box to adjust the duration. The initial setting is 10 mil-
liseconds. The range is from 0 milliseconds to 2,000 milliseconds. The most
useful range for normal editing functions is from 10 to 50 milliseconds. (The
scroll bar has exponential scaling so there is plenty of resolution around the
most useful settings.) The illustration below shows the effect of changing
the Blend Time control.

Blend Taper
The slope of the crossfade can be changed by using the Blend Taper scroll
bar or text box. The range of settings is from 0 (linear) to 100 (equal power).

Blend Time = 0 milliseconds

Blend Time = 10 milliseconds

Blend Time = 25 milliseconds
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Saving The SoundÞle
The initial setting is 0 (full linear). The illustration below shows the effect of
changing the Blend Taper control. 

Saving The Soundfile

Save
Because INFINITY uses disk based documents, changes to the soundÞle are
saved as they occur. The Save command in the Edit menu updates the
backup Þle (if one exists) so that a Revert to Backup command will revert
the soundÞle to the most recently saved backup. The Save command in the
Edit menu is selectable after a change has been made in the soundÞle. 

If the soundÞle has been changed and a backup Þle exists, closing the
soundÞle will cause the following dialog to appear.

Save A CopyÉ
Use the Save a CopyÉ command to save the soundÞle in a different folder,
with a different Þle name, or in a different Þle format. This command is use-
ful to make a series of samples for later comparison. 

Blend Taper = 100 (equal power)

Blend Taper = 0 (linear)

Linear taper should be used for 
editing simple periodic wave-
forms like solo instruments. 
Equal power taper should be 
used when editing complex 
non-periodic waveforms like 
string sections, noise, etc.
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To use the Save a CopyÉ command:

1. Choose Save a CopyÉ from the File menu.

The Save a Copy dialog box appears.

2. Type a new Þle name in the Save SoundÞle As text box.

3. Choose a Þle format from the three options listed.

Use this format: To save as a:

Audio IFF Apple Audio Interchange File Format document.

Sound Designer I Digidesign Sound Designer I mono soundÞle.

Sound Designer II Digidesign Sound Designer II mono or stereo 
soundÞle.

4. Click on Save.

A copy of the active soundÞle will be stored on disk with the name and 
Þle type speciÞed.

Reverting To The Last Saved Version

Choosing Revert to Backup from the File menu causes the soundÞle to
revert to the version last saved with the Save command. This command is
enabled only if a backup Þle has been created for the active soundÞle. 
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Customizing Your Environment
Customizing Your Environment

When INFINITY is Þrst started, the look of the soundÞle windows is prede-
termined. The appearance of the soundÞle windows can be customized and
some of INFINITYÕs behaviors can be modiÞed by using the PreferencesÉ
dialog in the Display menu.

Enable Clipboard

Unchecking Enable Clipboard discards the Clipboard contents and disables
Cut and Copy. Because no Clipboard exists, Paste and Mix cannot be used
and are therefore disabled. Clear, Clear Unselected, Invert, Reverse, and
Silence are still enabled. Unchecking this item saves the time and disk space
used to copy data into and out of the Clipboard.

Enable Undo

When the Undo function is enabled, INFINITY creates a temporary Undo
Þle every time an edit occurs. Unchecking the Enable Undo option
decreases the time and the disk space needed to complete edits on large
portions of data.

Blending

Checking this item enables the Blending function. This function was dis-
cussed above in ÒUsing Edit BlendingÓ on page 50.

Create Backup Files

When this item is checked, opening or saving a soundÞle will create a tem-
porary backup copy of the Þle. This allows the Revert to Backup command
in the File menu to be used. 
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Files that are opened with Create Backup Files checked will display the
phrase ÒBackup CreatedÓ in their title bar. This indicates that there is a copy
of the last saved version of the soundÞle. Each time Save is used, this
backup copy is deleted and the current sound is used to create a new
backup Þle. 

Creating backup Þles can take an inconveniently long time when working
with large soundÞles. Also, there may be insufÞcient space on your hard
disk to store the backups. If either of these conditions apply, uncheck the
Create Backup Files item. The title bar for a Þle opened in this condition will
display the phrase ÒNo BackupÓ. 

NOTE: Be forewarned that when ÒNo BackupÓ is displayed in the title bar,
any changes you make to the soundÞle will be permanent unless Undo is
enabled.

Customizing The SoundÞle Window

The appearance of the soundÞle window can be changed by using the
soundÞle window options in the PreferencesÉ dialog.

To: Do this:

Display the dotted zero crossing lines: Check the box next to Over-
view or Mainview.

Display track divider lines: Check the box next to Over-
view or Mainview.

Change the units on the Vertical Annotation: Use the pop-up menu to select 
Sample value or percent of full 
scale.

Change the units on the Horizontal Annotation: Use the pop-up menu. See the 
reference section for more 
information about these 
options.
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CHAPTER 4 INFINITY Looping Tools
The looping tools in INFINITY are easy to use and provide extraordinary
results. To use them most effectively requires some understanding of the
types of sound you are working on and the way the tools operate on the
sound data. The following chapter explains, in detail, the operation of
INFINITYÕs looping tools. 

Managing Loop Points

Real Time Loop Adjust

INFINITY allows the location of the loop points to be changed during play-
back. To move a loop point during playback, drag it to its new location by
pressing somewhere near the base of the loop point in the Horizontal Anno-
tation. The loop points can be dragged over each other. The loop point
which is on the left then becomes the Loop Start.

∞ To move both loop points simultaneously, while preserving the loop
length, press <option> while dragging either loop point.

The real time loop adjust feature can be used to rough set the loop points
when working with sounds that change over time. If you are working on a
stable loop, set the loop points around a region which is relatively stable in
pitch, timbre, and loudness. If you are making a loop which includes a
vibrato or tremolo, set the loop start and end to include several vibrato
cycles.
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A more precise way to set the loop points is to use the Smart Auto-Scan fea-
ture described below.

Undo Loop Move

Undo Loop Move is on the edit menu. Undo Loop Move is enabled only
after loop points have been dragged in the sound window or moved using
the crossfade dialog window.  Pressing Undo Loop Move undoes the previ-
ous loop move.  Pressing a second time redoes the previous loop move.
Edits: cut clear, paste, clear unselected, and reverse, when they change the
loop positions, will disable Undo Loop Move.  If the loop points are not
changed by edits, Undo Loop Move remains enabled.  Please remember
that : normal edit Undo recovers any loop points changed by the edit.
Using any of the looping tools (except the Crossfade Looper) will disable
Undo Loop Move.

Loop Points and Clipboard

The loop points are copied onto the clipboard.  This occurs with a cut or
copy if both loop points are included in selection.  Valid loops points in clip-
board show up as at least one non-zero value for the begin or end loop time
(see the "Show Clipboard" option in the "Edit" menu).  The values displayed
in "Show Clipboard"  are relative to the beginning of the selection when the
cut or copy  was performed.  When Paste is used and loop points are in clip-
board, they are always pasted into the document.

Loop Points During Edits
The loop points are moved only if all tracks are selected in Cut, Clear, Paste,
and Reverse operations. Loop points are always moved for Clear Unse-
lected. The loop points are never moved for Silence and Invert operations.

If both loop points are in an area that is cut from the data, they are deleted.
Undo restores the previous loop points.

During Cut and Clear operations, a loop point that is within the selection is
moved to the new insertion point. (If this happens to both loop points, the
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The Crossfade Looper
loop is deleted.) Loop points after the selection end point are moved for-
ward, ÒstuckÓ to their respective sample.

During Paste operations, where there is a selection, a loop point in the
selected region stays at the same number of samples after the selection start
point unless the pasted region is smaller than that offset. In that case, it is
moved to the Þrst sample after the new pasted region. Loop points after the
selection end point are ÒstuckÓ to their respective sample. During Paste
operations where there is an insertion point, loop points after the insertion
point are moved backwards, ÒstuckÓ to their respective sample.

During the Clear Unselected operation, loop points in the discarded regions
are moved to the Þrst or last sample of the soundÞle. Loop points within the
selected region are ÒstuckÓ to their respective sample.

During the Reverse operation, loop points in the selected region are
reversed as if ÒstuckÓ to their respective sample.

Loop Points In Other File Formats
Two loop points exist in the AIFF and the Sound Designer I formats, the
sustain loop and the release loop. Currently, INFINITY only deals with the
sustain loop.

In Sound Designer II, the sustain loop is called Loop 1 and the release loop
is called Loop 2. INFINITY will read only Loop 1 from a Sound Designer
Þle as the sustain loop. When INFINITY writes to a Sound Designer II Þle,
all other loops are lost.

The Crossfade Looper

The standard crossfade loop is created by blending part of the attack seg-
ment into the end of the loop segment of the soundÞle to create a smooth
transition back to the loop start. INFINITYÕs Crossfade Looper allows for
precise control of the process and contains many enhancements including a
scalable looping display, a non-destructive audition feature, fully adjustable
crossfade parameters, and an intelligent loop point scanning technology
called Smart Auto-Scan. This section explains these features and their con-
trols.
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The soundÞle can be auditioned while the Crossfade Looper is the active
window. Playback works by pressing the space bar or clicking on the
Speaker icon. If the cursor is in a text box, playback can be started only with
the Speaker Icon. Terminate playback by clicking on the Speaker icon or
pressing the space bar. During playback, unusable controls are grayed.

About Smart Auto-Scan

This algorithm searches the soundÞle for places where the sound at one
loop point matches the sound at the other loop point. The closeness of the
match and the number of places in the soundÞle that are searched are con-
trollable using the Auto-Scan SettingsÉ dialog shown below.

Conventional ÒautoÓ functions move the loop points to the nearest zero
crossing or the nearest zero crossing with the same slope. Smart Auto-Scan
compares the amplitude and the phase of the major harmonics at the loop
points and searches until a good match is found. The result is a loop point
which always creates good crossfade loops, i.e. without unwanted phase
cancellations of the major harmonics. The illustration below shows the

Looping Display

Auto-Scan Arrows

Auto-Scan
Matching Value
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The Crossfade Looper
result of a Smart Auto-Scan; the alignment of the waveforms is exact. The
slopes at the loop interface will blend after the crossfade is complete.

Understanding The Dialog Controls

SoundÞle Menu

The SoundÞle Menu shows the name of the last active soundÞle. All open
soundÞles are listed in the menu. The Crossfade Looper operates on the
soundÞle which is displayed in the menu.

Looping Display

The Looping Display shows the interface between the loop end and the
loop start. The vertical line in the middle of the display shows the interface
point. The left half shows the Loop End region, the right shows the Loop
Start region. Certain combinations of display resolution and loop point
positions will show the loop point in the opposite display. In this case, the
loop point marker is shown as a vertical line.

The display resolution can be changed using the Display Scale Arrows on
the Palette. The position of the cursor is also shown in the Palette cursor
tracking display.
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Auto-Scan Arrows

Clicking on a double arrow will cause INFINITY to begin searching for a
matching loop point in the direction of the arrow. When one is found, the
loop point marker is moved to the new location. 

INFINITY will continue to search until it Þnds a matching value which is
greater than or equal to the value of the Matching Threshold set in the
Auto-Scan Settings dialog. If none is found, an audio signal will sound,
indicating the end of the search. The loop points will remain in their origi-
nal locations. Pressing <esc> or <command-period> will terminate the
search. 

Clicking on a single arrow will move the loop point one pixel in the direc-
tion of the arrow. Pressing on a single arrow will cause the loop point to
move and slowly accelerate. The longer the arrow is pressed, the faster the
loop point will move.

Auto-Scan Matching Value

This displays the matching values found during Auto-Scan searches.
Watching this value during the search gives you an idea of how closely the
sound at the loop points is matching. Use this information to change the
Matching Threshold in the Auto-Scan Settings dialog, if necessary.

Auto-Scan SettingsÉ

Clicking on the Auto-Scan SettingsÉ command button will bring up the
dialog shown below.
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Matching Threshold
The Matching Threshold determines how closely the loop end must match
the loop start. The range of the control is from zero to 100. Higher numbers
require a closer match. A value of 100 equals a perfect match. Non-periodic
sounds typically have lower matching values than periodic sounds.

Match Trial Points
This control changes the number of locations in the soundÞle which are
searched during an Auto-Scan. The soundÞle is Þrst divided by the number
of Match Trial Points, then the search begins in the direction of the arrow
which was clicked. The range is from 10 to 1000. 

Crossfade Length (%)

This control adjusts the amount of attack data which is crossfaded with the
loop end to create a smooth transition back to the loop start. (For a review,
see ÒCrossfade LoopsÓ on page 19.) The range is from 0% to 100% of the
attack segment. If the loop segment is shorter than the attack segment, then
the crossfade length percentage refers to the amount of the loop data which
is effected by the crossfade.

Crossfade Taper

This control adjusts the taper shape of the crossfade that is used to blend
the attack and loop segments. It is adjustable from 0 (linear taper) to 100
(equal power taper). It should be adjusted to provide the smoothest transi-
tion between the attack and loop segments of the sample. Use equal power
taper for string sounds, choruses, and other non-periodic sounds. Linear
taper is best used with periodic waveforms like solo instruments.

Audition Crossfade

When the Audition Crossfade checkbox is checked, clicking on the Speaker
icon (or pressing the space bar) will compute the crossfade loop and play it

0 (linear taper)

100 (equal power taper)

Linear taper should be used for 
editing simple periodic wave-
forms like solo instruments. 
Equal power taper should be 
used when editing complex non-
periodic waveforms like string 
sections, noise, etc.
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until the Speaker icon is clicked again. This feature allows you to hear the
crossfade without permanently changing the soundÞle.

Do Crossfade

Clicking on the Do Crossfade command button executes the crossfade loop
process. Pressing <esc> or <command-period> terminates the process.

The Freeze Looper

The Freeze Looper is an automatic looping algorithm that creates a per-
fectly seamless loop with no sonic variations. It is excellent for making
short loops in relatively periodic sounds like solo instruments, and for
ÒfreezingÓ the timbre of decaying instruments that have clearly deÞned
harmonics like harp, piano, guitar notes, etc.

If the sound to be looped has nearly uniform waveshapes, the Freeze
Looper will change the aural qualities of the sound very little and result in a
continuous uniform loop. If the Freeze Looper is used on a more complex
sound, the resulting loop will sound very different from the original.

The crossfade used in the Freeze Looper is different from a normal cross-
fade loop in that a portion of the loop segment is blended into the attack
rather than a portion of the attack being blended into the loop. This modiÞ-
cation of the attack segment occurs every time a Freeze Loop is created.
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The Freeze Looper
How It Works
The Freeze Looper quantizes all the sound energy in the loop to a precise
harmonic series, giving a waveform that is perfectly repeated in every
cycle. The Freeze Looper outputs a constant pitch equal to the average pitch
of the original loop segment.

The Freeze Looper uses the MIDI Note Number to set internal processing
parameters. Because these settings effect the results, the MIDI Note Num-
ber should be set to the approximate pitch of the sound being looped.

The size of the loop segment is reduced by processing with the Freeze
Looper. The loop end point is moved to shorten the loop. The loop start is
left where it was before processing. This shortening is necessary because the
Freeze Looper uses an FFT algorithm that requires the number of samples
in the loop be equal to a power of two. The Þnished loop is also shortened
slightly so that it contains an integral number of waveform periods. So, the
output loop end point will be earlier than that which was input.

If the computations cause the loop data to exceed 90% of maximum, the
entire Þle will be scaled so that the loop data are 90% of maximum and
thereby do not clip.  Thus, data are scaled so no overßow occurs.  When
scaling occurs, the user is notiÞed with an alert which indicates how much
the data was scaled.  The scaling information will allow you to maintain
volume control of your samples.  If you are getting clipping in the fade from
the attack segment, check out that the crossfade taper may be set more
towards "linear taper".

Understanding The Dialog Controls

SoundÞle Menu

The SoundÞle Menu shows the name of the last active soundÞle. All open
soundÞles are listed in the menu. The Freeze Looper operates on the sound-
Þle which is displayed in the menu.

Pitch Control Radio

Previously, Freeze Looper had "Pitch Detection" built-in.  This means the
harmonic series energy distribution and output tuning was determined by
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an algorithm that detected the exact pitch of the original loop.  The MIDI
note was used as an initial guide such that if the MIDI note was way off, an
incorrect result would occur.  This algorithm is used when you select the
"Pitch Detection" radio. 

Unfortunately, if you process a short loop (less than 20 cycles), the "Pitch
Detection" algorithm will not be precise and the result may be slightly out
of tune.  Also, it may be the original sample was out of tune and you wish to
tune it up.  In these cases, you should select the "MIDI Note" radio.  This
will force the the harmonic series energy distribution and output tuning to
be determined using the "MIDI Note" number of the sample and the stan-
dard that A3 is 440Hz.

Pre-condition Data (%)

The purpose of the Pre-condition Data feature is to taper the data at the
loop start and loop end so that all the energy components in the loop begin
and end on zero. The control has a range from 0% to 100%. Any setting
larger than a few percent leaves little or no energy at the loop points to
cause a click which might inject unwanted noise into the process. 

Increasing the Pre-conditioning percentage favors the timbre of the sound
near the middle of the loop. Using different values gives different aural
qualities to the resulting sound. The diagram below shows the effect of
changing the amount of the loop tapered by the Pre-conditioning process.
(The taper does not show up in the Þnished loop.)

Loop Data Amplitude as a 
function of Pre-condition 
Data Percentage.
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The Freeze Looper
Crossfade Length

This control sets the amount of the loop that is blended with the attack seg-
ment. It is variable from 0% to 100% of the attack duration. A large cross-
fade length will cause the attack to slowly blend into the loop sound. A
smaller crossfade length will create a quick but blended transition between
the two segments of the sample. A setting of zero creates no crossfade.

Crossfade Taper

This control adjusts the taper shape of the crossfade that is used in the
attack/loop merge. It is adjustable from 0 (linear taper) to 100 (equal power
taper). It should be adjusted to provide the smoothest transition between
the attack and loop segments of the sample. 

Do It

Clicking on the Do It command button executes the Freeze looping process.
Pressing <esc> or <command-period> terminates the process.

Attack 
Segment

Loop 
Segment

50%

0 (linear taper)

100 (equal power taper)

Linear taper should be used for 
editing simple periodic wave-
forms like solo instruments. 
Equal power taper should be 
used when editing complex 
non-periodic waveforms like 
string sections, noise, etc.
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The Rotated Sums Looper

The Rotated Sums Looper creates seamless loops by randomly distributing
sonic irregularities throughout the loop. It is very effective with sounds that
have non-periodic waveforms like chorus, string orchestra, complex synth
patches, sounds that include noise, and so on.

NOTE: Sounds must be pre-looped before using the Rotated Sums Looper.
Any clicks, pops or other irregularities will be distributed throughout the
loop and show up as noise. Use the Crossfade Looper to smooth out the
loop data before processing with the Rotated Sums Looper. 

Use the Smart Auto-Scan feature of the Crossfade Looper to place the loop
points before processing with the Rotated Sums Looper. This will insure
that the resulting loop will more closely match the tone color of the original
data. 

If the computations cause the loop data to exceed 90% of maximum, the
entire Þle will be scaled so that the loop data are 90% of maximum and
thereby do not clip.  Thus, data are scaled so no overßow occurs.  When
scaling occurs, the user is notiÞed with an alert which indicates how much
the data was scaled.  The scaling information will allow you to maintain
volume control of your samples.  If you are getting clipping in the fade from
the attack segment, check out that the crossfade taper may be set more
towards "linear taper".
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How It Works

In a crossfade loop, all of the different frequencies in the sound make a tran-
sition from one phase to another during the crossfade. This causes different
combinations of constructive and destructive interference at the location of
the crossfade. Because this happens for all frequencies at the same point in
the loop, a noticeable ÒbumpÓ is produced by the crossfade looping process.

The Rotated Sums Looper creates a seamless loop by adding together many
random rotations of the input loop, thereby distributing the irregularity of
the crossfade ÒbumpÓ throughout the loop. This is a time domain solution
to the crossfade ÒbumpÓ problem in complex sounds. The more rotations
that are chosen, the better the results, up to a limit that exists because of the
natural variations in the sound. The Rotated Sums Looper does not change
the length of the loop.

Because the Rotated Sums Looper chooses random amounts by which to
perform loop rotations, different trials using the same input sound will
yield different results. 

Understanding The Dialog Controls
The Rotated Sums Looper divides the looping process into two distinct
phases; processing the loop data, and merging the attack and loop seg-
ments. These can be controlled separately and executed at different times. 

With both phases of the process enabled, the loop data and the attack data
are altered every time the Rotated Sums process is run. It is sometimes
desirable to disable the attack/loop merge phase of the process, and do sev-
eral ÒtakesÓ of processing the loop data without merging the loop with the
attack. This saves time and allows for selecting the best sounding loop
before the attack segment is altered by merging. After the best sounding
loop is found, the merge can be done separately by disabling the loop pro-
cessing phase.

SoundÞle Menu

This menu has the same function as in the other loopers.
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Process The Loop Segment

Check this item if you wish to apply the Rotated Sums process to the data
inside loop. When this item is not checked, the slider labeled ÒRotation
CountÓ is inactive and no change will be made to the loop data. 

Rotation Count
The Rotation Count is the number of times that the loop data will be rotated
and added in the accumulator during the loop processing phase. The range
of the control is from 1 to 100. More rotations give better results, up to a
point, but take more time.

Merge The Attack And Loop Segments

Checking this item enables the second phase of the looping process; merg-
ing the loop segment with the attack segment of the sample. Enable this
part of the process only when you want to crossfade the loop data with the
attack segment of the sound. When this item is not checked, the sliders
labeled ÒLoop Start Test PointsÓ, ÒCrossfade LengthÓ, and ÒCrossfade
TaperÓ are inactive.

When ÒMerge the Attack and Loop SegmentsÓ is checked in the dialog,
INFINITY will automatically search a number of points in the loop segment
to Þnd the point which most closely correlates to the end of the attack seg-
ment. The number of test points that are tried during the search can be con-
trolled using the Loop Start Test Points control. Processing time increases as
more points are tried. 

When the best merge point is found, INFINITY rotates the data in the loop
until the merge point is located at the loop start. The loop is then merged
with the attack segment. The type of crossfade that is used only modiÞes
the attack segment. The length and taper of the crossfade that is used to
merge the two segments can be controlled.

Loop Start Test Points
This controls the number of points that are tested during the search phase
of the merging process. It is variable from 0 to 100 points. A large number of
test points results in a better attack/loop merge but will also increase the
processing time.

Crossfade Length
This control sets the amount of the loop that is blended with the attack seg-
ment. It is variable from 0% to 100% of the attack duration. A large cross-
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fade length will cause the attack to slowly blend into the loop sound. A
smaller crossfade length will create a quick but blended transition between
the two segments of the sample. A setting of zero creates no crossfade.

Crossfade Taper
This control adjusts the taper shape of the crossfade that is used in the
attack/loop merge. It is adjustable from 0 (linear taper) to 100 (equal power
taper). It should be adjusted to provide the smoothest transition between
the attack and loop segments of the sample. 

0 (linear taper)

100 (equal power taper)

Linear taper should be used for 
editing simple periodic wave-
forms like solo instruments. 
Equal power taper should be 
used when editing complex 
non-periodic waveforms like 
string sections, noise, etc.
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The SPR Looper

The SPR Looper uses a patented process which randomizes the phase of
each spectral component in the loop. SPR means ÒSpectral Phase Random-
izationÓ. It is excellent for looping sounds which have very non-periodic
waveforms. It is especially good at looping complex sounds which require
exact preservation of the original tone color like string sections, choirs, and
so on.

How It Works
The SPR Looper is similar to the Rotated Sums Looper in that it rotates loop
data a random amount through the loop. The difference with the SPR
Looper is that it treats every constituent frequency of the loop separately.
This approach is more thorough than the Rotated Sums Looper. Because the
SPR Looper rotates each spectral component randomly, different trials
using the same input sound will yield different results.

If the computations cause the loop data to exceed 90% of maximum, the
entire Þle will be scaled so that the loop data are 90% of maximum and
thereby do not clip.  Thus, data are scaled so no overßow occurs.  When
scaling occurs, the user is notiÞed with an alert which indicates how much
the data was scaled.  The scaling information will allow you to maintain
volume control of your samples.  If you are getting clipping in the fade from
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the attack segment, check out that the crossfade taper may be set more
towards "linear taper".

Performance Note
Sometimes the Rotated Sums Looper and the SPR Looper have an undesir-
able effect on the output loop. The energy of any transient sound in the loop
will be distributed evenly over the length of the loop. Clicks and pops will
be output as relatively steady state noise.

For example, when looping a close miked Ôcello, the bow rasp, which nor-
mally occurs in phase with the rest of the waveform, is distributed ran-
domly across the loop. The result sounds like the Ôcello mixed with tape
hiss. We recommend that these two tools be used only with instrumental
groups or other random non-periodic waveforms.

Understanding SPR Controls
The SPR Looper divides the looping process into two distinct phases; pro-
cessing the loop data, and merging the attack and loop segments. These can
be controlled separately and executed at different times. 

With both phases of the process enabled, the loop data and the attack data
are altered every time the SPR process is run. It is sometimes desirable to
disable the attack/loop merge phase of the process, and do several ÒtakesÓ
of processing the loop data without merging the loop with the attack. This
saves time and allows for selecting the best sounding loop before the attack
segment is altered by merging. After the best sounding loop is found, the
merge can be done separately by disabling the loop processing phase.

SoundÞle Menu

This menu has the same function as in the other loopers.

Process The Loop Segment

Check this item if you wish to apply the SPR process to the data inside loop.
When this item is not checked, the slider labeled ÒPre-condition Data (%) is
inactive and no change will be made to the loop data.
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Pre-condition Data (%)
The Freeze Looper and the SPR Looper both use the Pre-condition Data fea-
ture before processing the loop data. The purpose of this feature is to taper
the data at the loop start and loop end so that all the energy components in
the loop begin and end on zero. The control has a range from 0% to 100%.
Any setting larger than a few percent leaves little or no energy at the loop
points to cause a click which might inject unwanted noise into the process. 

Increasing the Pre-conditioning percentage favors the timbre of the sound
near the middle of the loop. Using different values gives different aural
qualities to the resulting sound. The diagram below shows the effect of
changing the amount of the loop tapered by the Pre-conditioning process.
(The taper does not show up in the Þnished loop.)

Merge The Attack And Loop Segments

Checking this item enables the second phase of the looping process; merg-
ing the loop segment with the attack segment of the sample. Enable this
part of the process only when you want to crossfade the loop data with the
attack segment of the sound. When this item is not checked, the sliders
labeled ÒLoop Start Test PointsÓ, ÒCrossfade LengthÓ, and ÒCrossfade
TaperÓ are inactive.

When ÒMerge the Attack and Loop SegmentsÓ is checked in the dialog,
INFINITY will automatically search a number of points in the loop segment
to Þnd the point which most closely correlates to the end of the attack seg-
ment. The number of test points that are tried during the search can be con-
trolled using the Loop Start Test Points control. Processing time increases as
more points are tried. 

Loop Data Amplitude as a 
function of Pre-condition Data 
Percentage.
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When the best merge point is found, INFINITY rotates the data in the loop
until the merge point is located at the loop start. The loop is then merged
with the attack segment. The type of crossfade that is used only modiÞes
the attack segment. The length and taper of the crossfade that is used to
merge the two segments can be controlled. 

Loop Start Test Points
This controls the number of points that are tested during the search phase
of the merging process. It works as in the Rotated Sums Looper.

Crossfade Length
This control sets the amount of the loop that is blended with the attack seg-
ment. It is variable from 0% to 100% of the attack duration. A large cross-
fade length will cause the attack to slowly blend into the loop sound. A
smaller crossfade length will create a quick but blended transition between
the two segments of the sample. A setting of zero creates no crossfade.

Crossfade Taper
This control adjusts the taper shape of the crossfade that is used in the
attack/loop merge. It is adjustable from 0 (linear taper) to 100 (equal power
taper). It should be adjusted to provide the smoothest transition between
the attack and loop segments of the sample. 

0 (linear taper)

100 (equal power taper)

Linear taper should be used for 
editing simple periodic wave-
forms like solo instruments. 
Equal power taper should be 
used when editing complex 
non-periodic waveforms like 
string sections, noise, etc.
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The Synthesis Looper

Introduction

The Synthesis Looper tool can be used to selectively smooth out lumpy
sounding frequencies in chorused and ensemble sounds.  The new sound is
more stable and loop repetitions are less noticeable.  This control is
achieved by allowing you to specify the sidelobe widths of the harmonic
series as a function of frequency.   You can control the sidelobe widths to
continuously range from the wide sidelobes of the original ensemble sound
to the zero width sidelobes of the Freeze Looper.

This tool is appropriately used on chorused and ensemble sounds where
the instruments are playing the same notes or notes in octaves.  This tool
can also be used as a sophisticated chorusing effect, to generate an ensem-
ble sound from a solo instrument sound.

This tool is designed for use on monaural sounds.  Stereo sounds can be
processed, however, the phase relationships that determine stereo position-
ing will be lost.  The resulting stereo sound will have a random phase rela-
tionship, yielding a distributed spatial quality.

Commentary

There are two classiÞcations of sound.  The Þrst classiÞcation is solo instru-
ments (sans vibrato).  These generate uniformly repeated waveforms.  A
generic crossfade loop can be used to loop these sounds, however the best
results will be had using the Freeze Looper.  The second classiÞcation is all
other sounds.  These are sounds that change over time.  Crossfade loop
quality becomes worse as the sounds become more complex.   The SPR
Looper and Rotated Sums are most often used to loop these sounds.  How-
ever, a basic problem remains:  No matter how perfectly the end of the loop
is connected to the beginning of the loop, the sound in between is still of a
quality that changes over time.  Hence, you will always "hear the loop"
because the varying sound repeats itself, over and over again.
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The Synthesis Looper
This quality of "hearing the loop" because the varying sound repeats itself,
is sometimes judged as a poor quality loop.  It this case, the loop-maker is
really wanting for a tool to change the sound to one which does not have as
much temporal variation. 

It is for this reason we have created the Synthesis Looper.  This tool gives
you control over that aspect of the sound which creates temporal variation:
the harmonic sidelobe widths.

Some Theory

Temporal variation occurs when two sinusoidal frequencies are not exactly
in tune.  For example, if one sine wave generator is tuned to 1000 Hz (Hertz
or cycles per second) and another is tuned to 1001 Hz, a 1 Hz "beat note"
will be produced.  A temporal variation will also occur when there is any
integer relation between the frequencies involved: if one sine wave genera-
tor is tuned to 500 Hz and another is tuned to 1001 Hz, a 1 Hz "beat note"
will also be produced. 

Many solo instruments (sans vibrato) generate uniformly repeated wave-
forms.  These sounds contain energy at the "fundamental" pitch, and "over-
tone" pitches, which have frequencies that are EXACT integer multiples of
the fundamental frequency.  These frequencies are called the harmonic
series.  For example, an oboe play "A-440" generates energy at frequencies
440 Hz, 880 Hz, 1320 Hz, 1760 Hz, etc.  Zero energy is generated at any
other frequencies (except for perhaps "white noise" generated at all frequen-
cies by air rushing through the instruments).

The second chair oboe, who does not have as much precision in pitch,
might play an A-440 out of tune, yielding energy at frequencies 441 Hz, 882
Hz, 1323 Hz, 1764 Hz, etc.  Notice how the differences in pitch increase pro-
portionately with the harmonic index (1, 2, 3, etc.).  These two players, play-
ing together will generate a sound with a 1 Hz beat note (a 1 second
repeated variation in sound).

Now suppose there were 100 oboes playing together (with vibratos).  What
would the energy as a function of frequency look like?  Remember the bell-
shaped curve?  Draw a line in the dirt, stand back and throw 100 pennies at
the line.  Most of them will land close to the line and some of them will land
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far from the line.  The number of pennies per inch will be highest at the line,
and lower farther from the line.  If you draw a graph of the number of pen-
nies per inch verses distance, you will plot a bell-shaped curve.  This is
technically described as a "Normal Probability Density Function" or Nor-
mal PDF.  If there were 100 oboes players, each playing their version of A-
440 together (with or without vibratos) , the energy distribution of the fun-
damental pitch as a function of frequency would form a Normal PDF
around 440 Hz.  The width of the distribution would depend on how good
the players were.  If they were very good players playing in tune and no
vibratos, the width would narrow.  If they were unskilled and/or added
vibratos, the width would be wider.  Since this Normal PDF is energy as a
function of frequency, concentrated at a single frequency, it is described as a
frequency with Sidelobe energy.

These 100 players would also generate energy at the harmonic frequencies.
The energy distribution of the harmonics as a function of frequency would
also form a Normal PDF.  As with two players in the example above, these
differences in pitch increase proportionately with the harmonic index.  Add
to this some elementary arithmetic about playing in octaves and we get the
following rules:

∞ Rule 1: An ensemble composed of instruments playing the same note or
notes in octaves will form an energy distribution as a function of fre-
quency having energy at the fundamental frequency and integer multi-
ples of the fundamental frequency.

∞ Rule 2:  The energy distribution at the fundamental frequency will form
a Normal PDF whose sidelobe width depends on the intonation quality
of the players:  in-tune players will generate a narrower sidelobes than
players who are more out of tune.

∞ Rule 3:  Each harmonic will have an energy distribution at its respective
harmonic frequency that forms a Normal PDF.  The sidelobe width of
each harmonic will increase in proportion to frequency with the Þrst
harmonic being two times wider than the fundamental, etc.

There is a Þnal rule for which the authors do not take credit:  Energy cannot
be created or destroyed.  Nor can energy change its frequency.  Acoustic
energy can change its form to heat.  None the less, if you are listening to two
ßutes playing slightly out of tune, then at the moment at which there is
silence at your ears, there is also at least one loud sound somewhere else in
the room.  Be advised that by moving your head, you will change what you
hear.
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How it Works

The Synthesis Looper tool calculates the energy at each fundamental and
harmonic frequency and allows you to specify the width of the sidelobes
the resulting looped sound will have.  In this way, you could take the
lumpy sound of a highly out-of-tune ensemble and change it to the
smoother sound of a higher quality ensemble, making the variations in the
loop repetition less noticeable.

There are other possibilities, too.  For example, you can change the Þrst few
harmonics to focus the energy in the sidelobes to zero.  This will stabilize
the sound and still provide the warmth of the ensemble at the higher fre-
quencies.  You could also, in the extremes, make a soloist into an ensemble
or an ensemble into a soloist.

You can view the Synthesis Looper window by selecting it from the "Loop-
ing Tools" menu item:First, you can use the pop-up menu at the top of the
dialog to select any of the open soundÞles for processing or playback.  You
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can also press the space bar or the speaker icon in the palette window to
play back the selected sound.

This tool performs one, or both, of two functions chosen using the check-
boxes "Process the Loop Segment" and "Merge the Attack and Loop Seg-
ments".  The latter function is the same as that in the SPR Looper and
Rotated Sums Looper.  It allows you to combine a looped sound into the
attack portion of the sound.  You can use both tools simultaneously or you
can Þrst create a satisfactory loop with "Process the Loop Segment" and
later, merge it using "Merge the Attack and Loop Segments".  Please see the
"InÞnity User's Manual" and/or balloon help for assistance with "Merge the
Attack and Loop Segments".

If the computations cause the loop data to exceed 90% of maximum, the
entire Þle will be scaled so that the loop data are 90% of maximum and
thereby do not clip.  Thus, data are scaled so no overßow occurs.  When
scaling occurs, the user is notiÞed with an alert which indicates how much
the data was scaled.  The scaling information will allow you to maintain
volume control of your samples.  If you are getting clipping in the fade from
the attack segment, check out that the crossfade taper may be set more
towards "linear taper".

Understanding Synthesis Looper Controls
The Synthesis Looper divides the looping process into two distinct phases;
processing the loop data, and merging the attack and loop segments. These
can be controlled separately and executed at different times. 

With both phases of the process enabled, the loop data and the attack data
are altered every time the Synthesis Looper process is run. It is sometimes
desirable to disable the attack/loop merge phase of the process, and do sev-
eral ÒtakesÓ of processing the loop data without merging the loop with the
attack. This saves time and allows for selecting the best sounding loop
before the attack segment is altered by merging. After the best sounding
loop is found, the merge can be done separately by disabling the loop pro-
cessing phase.
nual



The Synthesis Looper
Process the Loop Segment

In the "Process the Loop Segment" section, there are three controls.  The
"Pitch Control" allows you to choose "MIDI Note" or "Pitch Detection".
Selecting the "MIDI Note" radio button will cause the harmonic series fre-
quencies to be determined using the MIDI note.  If the loop data is not in
tune, incorrect harmonic amplitudes will be computed.  Selecting the "Pitch
Detection" radio button will cause the harmonic series frequencies to be
determined by the loop data using the MIDI note as a guide.  This is accu-
rate unless the data is too short.

% Retain Noise
The second control is the "% Retain Noise" slider and number box.  Some
sounds have a characteristic background noise, that when removed, makes
the sound less natural.  An example of this would be a cello section, where
the action of the bow on the string adds noise at all frequencies.  Other
sounds may have backround noise that is undesirable.  If this control set to
100, the noise ßoor on the output will be the same as on the input.  If it is set
to 0, the noise ßoor will be completely removed.  Intermediate values set
the noise ßoor (energy) proportionately. 

Sidelobe Width (%)
The third control is the "Sidelobe Width (%)" graph.  This speciÞes the out-
put sidelobe width as a percentage of the fundamental frequency.  This per-
centage is multiplied by the fundamental frequency to get a frequency
variation that is used as the standard deviation of the Normal PDF energy
distribution.  You use this graph by dragging either of the points to a
desired location to specify the desired sidelobe widths.  Note that whenever
this window is selected and your cursor is over this graph, you can view
the coordinates of the cursor location on the Status Display Area palette
window.  The sound of the result is very sensitive to the position of the left
point.  For this reason, the two text boxes are provided so that you can type
in numbers, giving you more accuracy than dragging the point on the
graph.  Note that the sidelobe width is speciÞed as 10 times the percentage,
that is, typing a 7 means .7 %.

Merge The Attack And Loop Segments

Checking this item enables the second phase of the looping process; merg-
ing the loop segment with the attack segment of the sample. Enable this
part of the process only when you want to crossfade the loop data with the
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attack segment of the sound. When this item is not checked, the sliders
labeled ÒLoop Start Test PointsÓ, ÒCrossfade LengthÓ, and ÒCrossfade
TaperÓ are inactive.

When ÒMerge the Attack and Loop SegmentsÓ is checked in the dialog,
INFINITY will automatically search a number of points in the loop segment
to Þnd the point which most closely correlates to the end of the attack seg-
ment. The number of test points that are tried during the search can be con-
trolled using the Loop Start Test Points control. Processing time increases as
more points are tried. 

When the best merge point is found, INFINITY rotates the data in the loop
until the merge point is located at the loop start. The loop is then merged
with the attack segment. The type of crossfade that is used only modiÞes
the attack segment. The length and taper of the crossfade that is used to
merge the two segments can be controlled. 

Loop Start Test Points
This controls the number of points that are tested during the search phase
of the merging process. It works as in the Rotated Sums Looper.

Crossfade Length
This control sets the amount of the loop that is blended with the attack seg-
ment. It is variable from 0% to 100% of the attack duration. A large cross-
fade length will cause the attack to slowly blend into the loop sound. A
smaller crossfade length will create a quick but blended transition between
the two segments of the sample. A setting of zero creates no crossfade.
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Crossfade Taper
This control adjusts the taper shape of the crossfade that is used in the
attack/loop merge. It is adjustable from 0 (linear taper) to 100 (equal power
taper). It should be adjusted to provide the smoothest transition between
the attack and loop segments of the sample. 

The Synthesis Looper Report
But how should you set the  "Sidelobe Width (%)" control?  How should
you choose "MIDI Note" or "Pitch Detection"?  The "Synthesis Looper
Report" will assist you in deciding these issues.  Select the "Report..." button
at the  bottom of the Synthesis Looper window.  This causes the "Synthesis
Looper Report" window to be generated:This window "belongs" to the

0 (linear taper)

100 (equal power taper)

Linear taper should be used for 
editing simple periodic wave-
forms like solo instruments. 
Equal power taper should be 
used when editing complex 
non-periodic waveforms like 
string sections, noise, etc.
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sound Þle.  The data in the window is computed from the soundÞle's loop
data at the moment you pressed the "Report..." button.  You may generate
as many reports for a soundÞle as you desire.  You may close a report by
clicking the "go-away" box in the top left.  If you close a soundÞle, all the
reports for that soundÞle are closed automatically.  You can also press the
space bar or the speaker icon in the palette window to play back the sound-
Þle to which this report belongs.  Remember though, if you modiÞed the
soundÞle after generating the report, you will hear the new soundÞle.

The "Fundamental (Hz)" number is the fundamental frequency.  It is com-
puted using the MIDI Note number or the Pitch detection method selected
when you pressed "Report...". 

The "Amplitude Spectrum (dB)" is the amplitude (square root of energy) of
the loop expressed in Decibels.  (Decibels are 20 * log(value).  Every 6 dB is
a approximately factor of 2. in amplitude.). 

The "Sidelobe Width (%)" graph shows  the sidelobe width computed from
the loop as a percentage of the fundamental frequency.  The scale presented
is the same as the "Sidelobe Width (%)" input graph in the tool.  This side-
lobe width is computed for the fundamental and each harmonic as the stan-
dard deviation of the energy distribution around the fundamental or
harmonic.  It is expressed as a percentage of the fundamental frequency.

Note that whenever this window is selected and your cursor is over the
"Amplitude Spectrum (dB)" or "Sidelobe Width (%)" graphs, you can view
the coordinates of the cursor location on the Status Display Area palette
window.

At the bottom of the report are Radio buttons labeled "Log scale" and "Lin-
ear Scale".  The Log scale allows more resolution at the low frequencies
where the audio content is the most important.  The Linear scale should
show an approximate linear increase in sidelobe width as a function of fre-
quency for ensembles where the instruments are playing the same notes
(with octaves allowed). 

The report above is shown using the log scale.  The report below is the same
report shown in linear scale.  The data is that of a string section.  Notice
how the sidelobe width increases approximately linearly with frequency.
Use the linear scale on a report of unprocessed loop data to help you estab-
lish what settings to use in the Synthesis Looper "Sidelobe Width (%)"
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graph.In this graph, you can easily see that the harmonics have frequencies

which are integer  multiples of the fundamental frequency.  Also, the Nor-
mal PDF distributions in energy show up as narrow concave downward
hyperbola (in Decibels verses linear frequency).  Notice how the higher fre-
quency harmonics are wider.  These sidelobe widths are proportional to fre-
quency.

Note that the above "Sidelobe Width (%)" graphs were generated using
pitch detection (see the note enclosed in the graph).  Pitch detection was
used here because this note was slightly out of tune.  You can determine this
because if the MIDI Note were used instead, the graph would appear:Nor-
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mally, the sidelobe widths do not exceed 30% unless the expected harmonic
frequency is not aligned to the actual harmonic frequency.  This will happen
when the MIDI Note is used for pitch control and the note is out of tune. 

The following graphs show the result of processing the data with the
"Retain Noise" checkbox clear and checked, respectively.

 "Retain Noise" unchecked:

Notice how the "Sidelobe Width (%)" becomes ßat above 12k Hz, as was
speciÞed in the "Sidelobe Width (%)" of the Synthesis Looper tool. 

With "Retain Noise" checked:
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Compare the above graph to the report of the unprocessed data and notice
how the noise ßoor has been computed to vary with frequency similar to
the initial data.  Also notice that the presence of noise causes the "Sidelobe
Width (%)" computation to be slightly excessive in frequencies where the
noise is nearly the same amplitude as the harmonic.

How To Loop A Sound:

First, set the sample's MIDI Note to as near the correct pitch as possible
using A3 = 440Hz.  Second, set the loop points.  Note that the Synthesis
Looper will make the loop smaller to the next power of two (approxi-
mately).  Open the Synthesis Looper tool.  Set the "Pitch Control" radio to
"MIDI Note" if you believe your sample should be in tune according to the
A3 = 440Hz equal tempered scale.  If not, set it to "Pitch Detection". 

Next, press the "Report..." button.  On the report, select "Log scale" and
place your cursor precisely at the fundamental peak.  Check that the "Fun-
damental (Hz):" number is within a pixel's accuracy of the "Hertz" number
on the ßoating palette.  If it is not, then you are going to have pitch prob-
lems:  If you had checked "MIDI Note" you either speciÞed the wrong note
or the data is not tuned to A3 = 440Hz equal tempered scale.  Either re-spec-
ify the note or use "Pitch Detection". If you had checked "Pitch Detection",
then your MIDI note may be off.  The MIDI note was used as an initial
guide by the pitch detection algorithm.  If the MIDI note is way off, an
incorrect result would occur.  Unfortunately, if you process a short loop
(less than 20 cycles), the "Pitch Detection" algorithm will not be precise and
the result may be slightly out of tune. 

Next, review the "Sidelobe width (%)" graph.  Normally, the sidelobe
widths do not exceed 30% unless the expected harmonic frequency is not
aligned to the actual harmonic frequency.  This will happen when the MIDI
Note is used for pitch control and the note is out of tune.  In this case, use
"Pitch Detection".

Next, go back to the Synthesis Looper tool and check "Retain Noise".

Finally, specify a "Sidelobe Width (%)" curve that resembles the one on your
report and press the "Do It" button.  This is a quality control step and
should result in a loop very close to your original sound. 
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Now the fun begins:  Select "Retain Noise" as desired.  Experiment by care-
fully adjusting the "Sidelobe Width (%)" curve to have less width than the
original and press "Do It".  (Remember to "Undo" between trails.)

A Final Note:
Remember this:  Ensemble sounds vary.  When you make a loop you will
hear the variations repeat, over, and over, and over, and over...  You can
make a static sound that doesn't vary (use zero Sidelobe Widths or use
Freeze Looper) but that won't sound like an ensemble.  You can't have it
both ways.

However, this tool lets you determine the trade-off, giving you unprece-
dented control of the of the result.
nual



APPENDIX A Keyboard Shortcuts
The keyboard command equivalents listed below are grouped by function.
For instance, commands that scroll the data in the Mainview are grouped
together. Keys that have names, like ÒshiftÓ, will be shown as <shift>. Two
named keys that are used together look like <shift-option>.

Pressing on the Palette and using Balloon Help will show many keyboard
shortcuts.

Scrolling Data
To: Key Command:

Scroll the Mainview to the right

Scroll the Mainview to the left

Scroll the Mainview up

Scroll the Mainview down

Scroll right by one windowful <shift>

Scroll left by one windowful <shift>

Scroll up by one windowful <shift>

Scroll down by one windowful <shift>

Scroll full left and center <Home>

Scroll the Mainview to the loop start - [

Scroll the Mainview to the loop end -]

Full zoom to the loop start function. <option>[

Full zoom to the loop end function. <option>]
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Changing Display Scaling
To: Key Command:

Double the vertical display resolution  

Halve the vertical display resolution  

Double the horizontal display resolution  

Halve the horizontal display resolution  

Go to minimum vertical display resolution <option>  

Go to maximum vertical display resolution <option>

Go to minimum horizontal display resolution <option>

Go to maximum horizontal display resolution <option>

Fit the current selection in the Mainview F

Full zoom to the loop start function. <option>[

Full zoom to the loop end function. <option>]

File Commands
To: Key Command:

Create a new soundÞle N

Open an existing soundÞle O

Close a window W

Save a soundÞle (update the backup Þle) S

Get information about a soundÞle I

Quit INFINITY Q
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Edit Commands
To: Key Command:

Cut data from the soundÞle into the Clipboard X

Copy data into the Clipboard C

Paste data from the Clipboard into the soundÞle V

Clear data from the soundÞle (delete) B or <delete>

To: Key Command:

Clear Unselected data from the soundÞle T

Mix M

Create or delete loop points P

Select the loop data L

Select all the data in the soundÞle A

To drag both loop points simultaneously <option> drag

Looping Tools
To: Key Command:

Call the SPR Looper 1

Call the Rotated Sums Looper 2

Call the Freeze Looper 3

Call the Crossfade Looper 4

Palette
To: Key Command:

Momentarily put the active window in Zoom Mode <control-shift>

Momentarily put the active window in Selection Mode <shift-option>

Play/Stop the active soundÞle <space bar>
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Create or delete loop points P

Scroll the Mainview to the loop start - [

Scroll the Mainview to the loop end -]

Fit the current selection in the Mainview F

Other
To cancel playback and many processing operations <esc> or < .>
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A
Action Icons 26
Amplitude Spectrum (dB) 84
Attack/loop merge 70
Audio IFF 54
Audition Crossfade 63
Auto-Scan 60
Auto-Scan Arrows 62
Auto-Scan Matching Value 62
Auto-Scan Settings… 62
Auto-Zero 48

B
Blend Parameters 52
Blend Taper 52
Blend Time 52

C
Changing The Display Resolution 33
chorused sound 76
chorusing effect 76
Clear 43
Clear Unselected 44
Clipboard 49
Close box 22
Copy 42
Create (Delete) Loop Points 47
Create /Delete Loop Points 47
Create Backup Files 55
Crossfade Length 67
Crossfade Length (%) 63
Crossfade Loops 19
Crossfade Taper 63, 67, 71, 72, 75, 83
Cut 41

D
Disk Based Files 28
Display Scale Icon 26, 33
Display Scaling 90
Do Crossfade 64

E
Edit Blend Settings dialog 52
Edit Blending 50
Edit Commands 91
Editing Functions 41
Editing the Soundfile 38
Enable Clipboard 55
Enable Undo 55
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ensemble sounds 76
Equal power taper 53, 63, 67, 71, 75, 83
equal power taper 67

F
File Commands 90
Fit Selection Icon 26
Fit Selection icon 33
Freeze Looper 64
Full Zoom In 35
Full Zoom Out 35
fundamental 77
Fundamental (Hz) 84

G
Get Info… 27
Grow Box 24

H
harmonic series 76
hear 76
hear the loop 76
Hide Overview 36
Horizontal Annotation 23, 56
Horizontal Scale Units 36

I
Ideal loop 17
Invert 45

K
Keyboard Command Equivalents 31, 89

L
Linear Scale 84
linear taper 67
Listening to The Soundfile 36
Log scale 84
Loop End Icon 26
Loop Points 24
Loop Points During Edits 58
Loop Points Icon 26
Loop Points In Other File Formats 59
Loop Points, locating 47
Loop Start Icon 26
Loop Start Test Points 70, 75, 82
Looping 17
Looping Display 61
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M
Mainview 23
Match Trial Points 63
Matching Threshold 63
Merge the Attack and Loop Segments 70, 74, 81
MIDI Note… 48
Minimum System Requirements 14
Mix 44
Mode Icons 25
monaural 76
monaural sounds 76

N
Non-periodic sounds 18
Normal PDF 78
Normal Probability Density Function 78

O
overtone 77
Overview 22, 36
Owner Registration 15

P
Palette 24
Paste 42
Periodic sounds 17
Pitch Control Radio 65
Playback Auto-Reset 37
Playback Position Pointer 23
Pre-condition Data 66, 74
Pre-condition Data (%) 66, 74

R
Real Time Loop Adjust 57
Reverse 45
Revert to Backup 54
Rotated Sums Looper 68
Rotation Count 70

S
Save 53
Save a Copy… 53
Scroll After Playback 37
Scrolling Data 89
Scrolling The Soundfile Data 32
scrolling the soundfile data 32
Selecting Data 39
Selection Icon 25
Selection Mode 40
INFINITY UserÕs Manual xcv



xcvi INFINITY UserÕs 
Selection Mode In The Mainview 38
Selection Mode In The Overview 40
Selection Mode, momentary 40
Set MIDI Note… 48
Show Clipboard… 49
Show Overview 36
Show Track Dividers 35
Show Zero Crossing 35
Sidelobe Width (%) 84
sidelobe widths 76
Silence 45
Smart Auto-Scan™ 60
solo instruments 76
Sound Designer I 54
Sound Designer II 54
Sound Playback 36
Soundfile Window 21
Speaker Icon 26
Speaker icon 37
Spectral Phase Randomization 72
SPR Looper 72
Stack Windows 36
Status Display 25

Amp 25
C 25
C-I 25
Track 25

Synthesis Looper 76

T
temporal variation 77
The Crossfade Looper 59
Tile Windows 36
Title Bar 22
Track Divider 23
Track divider lines 56

U
Undo Loop Move 58
Undoing A Command 32
uniformly repeated waveforms 76

V
Vertical Annotation 23, 56
Vertical Scale Units 35
View Indicator 22
Viewing The Soundfile 32
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Z
Zero Crossing 23
Zero crossing lines 56
Zoom box 22
Zoom Icon 25
Zoom Mode 33, 35
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